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n April 18, 2005 Adobe Systems 
Incorporated announced a 
definitive agreement to acquire 

Macromedia in an all-stock transaction 
valued at approximately $3.4 billion. What 
many do not realize is that these compa-
nies have been successfully “dating” in the 
digital publishing world for six years.
	 In 1999, Integration New Media Inc. 
(INM), based in Montreal, Canada envis-
aged cost-effective, smart, immersive 
applications that would make for a greatly 
improved experience for developers and 
end-users alike. Why not combine the 
strengths of Adobe and Macromedia to 
create the best possible user experience 
for those working in digital publishing?
	 It was a match made in heaven. 
Adobe’s PDF file format offered many 
advantages. A worldwide standard, PDF 
was universal and easy-to-use; it provided 
high-quality printing and display, cross-
platform capabilities and cost-effective 

production. 
	 Macromedia’s Director software 
offered an established and cost-effective 
multimedia development platform, full 
control over user interfaces, advanced 
multimedia and scripting capabilities. 
	 INM saw a natural link between the two 
products and thus created a bridge “PDF 
Xtra” that combined them. This Xtra, which 
has since evolved into the much more 
powerful INM Impressario Xtra, enabled 
PDF users to use Director as a container for 
their content. They could create a highly 
usable interface, selectively exposing users 
only to the functionality they needed. By 
developing a project with Director, the user 
interface enabled the delivery of highly 
intuitive applications and publications for 
E-Learning, E-Marketing or for any project 
wherein users must become engaged in 
the “blink of an eye” – quickly, easily and 
without a user manual.
	 Director developers benefited by 
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seamlessly integrating PDF documents 
into their multimedia publications for a 
blended look and feel. There was no need 
to recreate documents, as existing data-
sheets, drawings, and any other item that 
could be saved as a PDF could easily be 
integrated from a variety of sources. PDFs 
allowed for timeliness as well – content 
providers could incorporate up-to-date, 
last-minute content by simply changing 
the PDF file. No complicated programming 
or reformatting was required – PDF docu-
ments could be changed and replaced 
without affecting the Director movie itself. 
Another advantage was PDF technology’s 
ability to preserve advanced page layouts, 
including inline graphics, text wrapping, 
multiple columns, stylized fonts, special 
characters, etc. All of this content could be 
displayed and printed exactly as is, con-
sistently, across all platforms and systems, 
which was previously impossible through 
Director alone. Among other features, 
PDF documents could be searched within 
Director movies; content could be pass-
word-protected as well as personalized, 
enabling the use of forms, and more.
	 All of this led to an improved user 
experience. Period. And that was INM’s 
vision, now realized in a plethora of con-
tent-rich applications. For example, Sony 
UK recently commissioned developers at 
Blueburst Ltd. to develop an interactive 
marketing resource toolkit that would 
provide all the vital marketing materials 
required by resellers and distributors to 
sell the Sony Storage Media product line. 
	 This Toolkit CD enabled resellers and 
distributors to easily access product-
related image and text galleries, and cus-
tomize/co-brand Sony marketing collateral 
such as advertisements, direct mail pieces 
and e-shots, using their own contact 
information and logos. The material could 
then be used in catalogs, websites and 
marketing campaigns, making it easier 
for resellers and distributors to sell Sony 
Storage Media. In addition, because they 
were working with official Sony artwork, 
the branding of the product line remained 
consistent and Sony was able to maintain 
greater control over the product line’s 
image.
	 Blueburst Ltd. used INM Impressario 
to display and print several guideline 
documents pertaining to Sony’s logo and 
campaign text usage, as well as allow for 
customization of the print-ready artwork 
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(PDFs) of advertisements and direct mail 
pieces provided on the CD. “The image-
replace function proved invaluable to this 
project as it allowed end-users to easily 
customize the print-ready material with 
their own information,” says Ben Francis, 
Managing Director of Blueburst Ltd. 
“Without the combined functionality of 
PDF and Director, programming such a 
feature would have been much more dif-
ficult.”
	 McGraw Hill’s COSMOS, the Complete 
Online Solutions Manual Organization 
System, by Hunt and Gather Inc., is 
another example of how the merging of 
PDF and Director benefits digital publish-
ers. COSMOS is an assignment assembly 
product designed for college professors. 
This product supplies problems and solu-
tions (in PDF format) which professors 
can use to assemble and print assign-
ments, as well as enables professors to 
add their own customized equations. The 
COSMOS engine easily displays and prints 
the numerous PDF files from within the 
Director interface.
	 When it comes to applications that 
require an integration of PDF files into a 
Director interface, a CD-ROM developed 
by Sony DADC for optical manufacturer 
Swarovski is a perfect example. Over the 
last five years, the world of bird watch-
ing has been enriched by a new concept 
called digiscoping – photography taken 
with a compact digital camera located in 
the eyepiece of an observation telescope. 
By combining these two technologies, 
photos can be captured at a higher mag-
nification level. In order to help potential 
customers understand this new technol-
ogy, Sony DADC created a CD-ROM that 
provides technical terminology, tips for 
using digiscoping in the field, and other 
educational data. Sony DADC used INM 
Impressario to develop a customized navi-
gation toolbar that allows users to easily 
save, print, zoom in or out of specific areas 
of the CD-ROM’s PDF documents, and 
move seamlessly between pages.
	 Or, how about traveling to Tahiti without 
leaving your office or living room? The Tahiti 
Travel Guide, developed for Tahiti Tourism 
by Marc Bolard of GlopGlop Productions, is 
a collection of useful information for those 
planning a stay in French Polynesia. The CD-
ROM includes maps and information for all 
the islands, a detailed diving guide, pictures, 
event calendar, among other features. 
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	 The guide is distributed as a cross-
platform CD-ROM and is used by tourism 
professionals worldwide. With the CD, 
travel agents can quickly look-up infor-
mation on Tahiti in five different languag-
es. They can perform keyword searches, 
print documents, save information to 
their hard drives, and add bookmarks. 
They are also able to add comments and 
notes for future reference. Again, this is 
made possible by the seamless integra-
tion of PDFs into the CD-ROM interface. 
	 Developers of content-rich applica-
tions like E-Magazines also benefit from 
the PDF/Director synergy. Take the Military 
and Aerospace E-Magazine for example. It 
was created to provide new and existing 
customers of Xilinx Inc. with an interactive 
means of viewing their solutions. Meant to 
captivate the attention of the user while 
delivering an abundance of content, the 
75-page electronic magazine showcases a 
complete range of Xilinx offerings. Readers 
can browse through the publication using 
a page-turning effect; there is also an 
index that contains thumbnails of each 
page so that with a click of a mouse, read-
ers can jump straight to the article that 
interests them. A documentation page 
includes hyperlinks to over 50 additional 
product datasheets (PDFs) and web pages. 
Users are also able to print out the articles 
and datasheets, which are saved as PDF 
documents, straight from the application. 
Again, developers used INM Impressario to 
import and control the PDF content all the 
while continuing to design the E-Magazine 
in Director. 

	 On a larger scale, Sophonie - a pri-
vate French company specializing in 
digital document management systems – 
approached INM’s Consulting Services to 
adapt their INM Impressario technology 
to allow the company to easily package 
thousands of digital documents (PDFs) 
into customized and searchable virtual 
libraries. Sophonie’s systems are designed 
to handle large volumes of historic docu-
ments and rare books that would other-
wise not be accessible in their original 
printed versions (some documents are 
over 200 years old and date back to the 
French revolution!). 
	 INM set out to develop a toolkit that 
would allow Sophonie to easily produce 
their libraries without any programming 
and deliver them on CD/DVD-ROM. In 
turn, Sophonie’s clients would be able 
to sell these libraries and have more 
control over distribution. As primary 
end-users of such virtual libraries are 
researchers and professors seeking 
articles, each virtual library needed to be 
able to perform advanced searches in a 
user-friendly manner and to display and 
print facsimiles of the required docu-
ments. 
	 The result was the Boulix Virtual 
Library Builder that created custom-
izable virtual, multilingual libraries 
containing (on average) 60,000-70,000 
pages of text and indices. The Library 
Builder allows Sophonie to easily update 
content (including Flash movies, graph-
ics, buttons, color schemes, etc.) without 
any programming whatsoever. And, by 

delivering on CD/DVD-ROM or through 
server licensing, Sophonie’s clients can 
control distribution and access to their 
libraries. 
	 “This is exactly the ease-of-use we 
envisioned six years ago for companies 
developing and using multimedia appli-
cations such as these libraries, and the 
digital publications listed above,” says 
INM president Vahe Kassardjian. “Today, 
it is not enough to have only stable, fast 
software applications. Users expect soft-
ware to be intuitive and cost-effective 
– they expect an interface that guides 
them through the application, smoothly 
and seamlessly. That is what we are striv-
ing for.”
	 As evidenced by their long-time and 
successful “courtship” in the world of digi-
tal publishing software, the future certain-
ly bodes well for Adobe and Macromedia 
as well as for the users of their products-
to-be. 

Sony Marketing Toolkit Project pro-

vided by Blueburst Ltd. (http://www.

blueburst.com). COSMOS project pro-

vided by Hunt and Gather Inc. (http://

www.huntandgather.com). Swarovski 

Digiscoping provided by SONY DADC 

(http://www.sonydadc.com). Tahiti 

Travel Guide provide by GlopGlop 

Productions (http://www.glopglop.

com). Xilinx’s Military and Aerospace 

E-magazine provided by Xilinx Inc. 

(http://www.xilinx.com). Boulix Virtual 

Library Builder provided by Integration 

New Media Inc. (www.INM.com)

“INM set out to develop 
a toolkit that would allow 

Sophonie to easily produce 
their libraries without any 
programming and deliver 
them on CD/DVD-ROM”
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ou may have noticed recently 
that lots of websites now 
contain little graphical but-
tons with the word XML on 

them. For example:  or  or . When you 
click on the button, all you see is a bunch 
of jumbled text and computer code [ed: 
unless you have a newer web browser or 
an aggregator]. What’s this all about? It’s 
an RSS feed, and they’re changing the 
way people access the Internet.
	 RSS, or Really Simple Syndication, 
is a technical format that allows online 
publishers to share and distribute their 

content to other websites or individual 
Internet users. It’s commonly used for 
distributing headlines on news websites. 
Bloggers use it to distribute summaries of 
their blog entries as well. RSS is written in 
the Internet coding language known as 
XML, which is why you see RSS buttons 
labeled that way.
	 If a website publishes an RSS page, 
commonly known as an RSS “feed,” this 
feed will contain summaries of all the 
recent articles posted on that site. For 
example, Yahoo News publishes news 
related to world headlines, national news, 
sports, etc. These you can all read by 
going to the Yahoo website. But they also 
publish RSS feeds for each of these sub-
jects. Each RSS feed contains a summary 
of the most recent news stories posted. 
Similarly, the Digital Divide Network pub-
lishes RSS feeds for our news headlines, 
events listings and other content on our 
website. I even have my own RSS feed 
for articles that I publish on my personal 
blog, Andy Carvin’s Waste of Bandwidth.
	 So basically, as a consumer of content, 
RSS allows you to see updated content 
in news aggregators or web browsers 
(new ones have integrated this feature). 
It solves the what’s new problem for 
websites by allowing content consumers 
to subscribe to content that they find 
relevant. That means its a great way to 
communicate with a market that has 
already defined itself as interested in your 
content by having taken the first step of 
subscribing to the feed. It also solves the 
SPAM problem, because your market has 
already agreed to be targeted. Its permis-
sion marketing done right, and with no 
SPAM filter headaches.
	 RSS also solves another problem by 

allowing content to be syndicated (or 
republished) on other websites. This is 
how tools like Yahoo or Google News 
work. They collect RSS feeds from across 
the internet and then publish the rel-
evant ones on their site. Imagine the traf-
fic you would generate by getting a story 
published on one of those news portals. 
This opens up an entire new way to drive 
traffic to your site.
	 RSS is probably the most powerful 
marketing tool emerging in internet pub-
lishing today.

Publishing RSS Feeds
	 There are several tools for publishing 
RSS feeds widely available on the inter-
net, with a range of prices from free on 
up. The problem with most of the tools 
is that they require a good bit of work to 
get your content into the feed you are 
creating. With some, you have to copy 
and paste your content into their tool, 
which is simple for small amounts of 
content but not for larger websites. With 
other, you have to have PHP, ASP, or Perl 
on your webserver and use those tools 
to rework your content into a feed. In all 
cases, none of them are designed to inte-
grate directly with the primary tool you 
use to create the content of your website 
— Dreamweaver.
	 The right solution would take advan-
tage of the content you’ve already cre-
ated and the way that you manage that 
content using Dreamweaver. It would 
give you a way to leverage what you 
know to accomplish the task of creating a 
feed, without having to learn new tags for 
RSS and without having to become a CGI 
expert to program PHP/ASP/Perl.
	 That’s what RSS DreamFeeder does. 

Creating RSS Feeds with 
Dreamweaver

Publishing content online is evolving 
with a new technology called RSS.

by ronald northrip
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RSS DreamFeeder allows you to specify 
elements of the content you’re already 
creating for your website to be refor-
matted as an RSS feed. It integrates 
specialized search-engine technology 
into Dreamweaver with a simple float-
ing panel where you can create, edit, 
and process your content into RSS feeds. 
DreamFeeder’s panel lists new content 
that has been added to your site since the 
feed was last updated and will add that 
new content to your feeds when you tell 
it to. You don’t have to edit every entry in 
the feed, all you do is tell it to do the job. 
And it only does it when you’re ready and 
your new content is ready — avoiding 
problems with feeds pointing to articles 
still being created.

So Tell Me How!
	 OK. Let me tell you how. In this 
tutorial I’m going to outline two dif-
ferent styles of content, which broadly 
encompasses the two primary sets of 
web content that get converted to feeds 
— Single Pages and Directories. Single 
pages are single html files that contain 
multiple stories, each of which is treated 
as a unique entry to be linked to by the 
RSS feed. Directories contain multiple 
html files, each of which contains a single 
story and links to each must be entered 
in the RSS feed. RSS DreamFeeder, once 
configured, will do all of this automati-
cally for you when you process the feed. 
You can define multiple feeds for your 
website and each feed can have its own 
configuration.

Download the Pieces
	 You will, of course, need a copy of RSS 
DreamFeeder, available from RNSoftware 
at http://www.rnsoft.com/products/rss-
dreamfeeder
	 You install RSS DreamFeeder using the 
Extension Manager application that came 
with your copy of Dreamweaver. All you 
should have to do is double-click the MXP 
file that you downloaded and Extension 
Manager should launch and ask you if 
its OK to install. You may need to restart 
Dreamweaver after installing the exten-
sion but you don’t need to restart your 
computer.
	 To launch RSS DreamFeeder select 
RSS DreamFeeder from the Window 
menu in Dreamweaver. This will open 
the DreamFeeder panel and display a 
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list of rss files within the current website 
— you shouldn’t have anything in the list 
because you haven’t created them yet. If 
you click on the RSS DreamFeeder button 
in the bottom left corner you should see 
this panel. Click the Done button to go 
back to your feeds list.
	 You’ll probably want a news aggrega-
tor to test the feed with. You can use any 
one that you like, but here are a couple 
(the first ones that come up when I 
google “news aggregators download”):
	 • Ampheta Desk
	 • NetNewsWire 

(more at http://blogs.law.harvard.edu/
tech/directory/5/aggregators)
	 You might also try Firefox’s active 
bookmarks or Safari’s RSS reader.
	 I’ve also created a simple website with 
some basic content so you can see the 
process in action.You can download this 
demo site at http://www.rnsoft.com/
products/rssdreamfeeder/content/tuto-
rial/RDFDemoServer.zip
	 You will have to define this as a new 
website within Dreamweaver. I called 
the site RDFTutorial. You don’t need a 
remote site defined, just a local one, 
because RSS DreamFeeder works right 
from your local files, and includes only 
the new files you create. When you’re 
ready to publish the feed you create 
on your website you simply upload 
the RSS or XML file you created, just 
like you would for any HTML file. That 
means you get to manage your content 
the way that works best for you and 
your workflow.

The Files in the Site
	 To keep things simple, the demo 
website only contains a limited number 
of files. But to be authentic we created 
this site using CSS styles, templates, and 
library items, just like you would for your 
website. The files we are most interested 
in are the Home page — index.html 
in the root of the website — and the 
JobBank page — jobbank.html in the 03_
HumanResource directory (the individual 
jobs listed are stored in a the JobBank 
directory in there).

Feeding the Home Page
	 Open the home page and take a look 
at it. The home page is an example of 
a single html files that contain multiple 
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stories. I used a repeating block with 
a template, but you don’t have to, RSS 
DreamFeeder looks at the HTML code for 
the page, not the Dreamweaver markup. 
Each of these stories will need to be 
treated as a unique entry to be linked to 
by the RSS feed.
	 Imagine that we’ve just edited the 
content to add our update — Aug 27 
Employee Special. This content represents 
the story that we’ll want to collect for use 
in our RSS feed. The way we’ll collect this 
content is based on the HTML code used 
to layout the content. Take a close look at 
the content and notice a few things:
	 The headline is in a TD tag with a CSS 
style applied — HPStoryRevHead. The 
anchor defines the location to link to 
within the page for each story — it will 
get picked up by the RSS feed. The story 
content is a P tag with a CSS style applied 
— HPStoryContent
	 Now based on what we just looked 
at you’ll be able to define a feed for this 
page and use those attributes to identify 
the content to extract from the page and 
put into the RSS feed.
	 If RSS DreamFeeder isn’t already 
open, you can open it by selecting RSS 
DreamFeeder from the Window menu.
	 To create a new feed you click the 
New Feed button in the toolbar at the 
top of the panel. The panel will change 
and you will create the settings for the 
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technical format that 
allows online publishers 
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new feed. You’ll go through 5 panels with 
various settings that effect how your feed 
will work. Don’t worry, you only have to 
do this once, when you create the feed. 
These settings stick with the feed and 
are used when you process the feed to 
control its content. We’ll talk more about 
processing the feed later on. (Note: If 
your window doesn’t show the Next and 
Cancel buttons you may need to make it 
taller — I would have done it automati-
cally for you but Dreamweaver doesn’t 
allow it).
	 The first panel collects descriptive 
information about the RSS feed. You will 
need to enter the Title of the feed. You 
will also need to enter a Description for 
the feed. You may optionally include a 
graphic or icon to be used to represent 
the feed, but only in aggregators that 
support RSS v 1 formatted feeds. If you 
specify a graphic you probably also need 
to stick to RSS v1 for the format of your 
file (specified in a different step). Once 
you’re happy with your content you may 
click the Next button to proceed to the 
next panel in the series.
	 The second panel defines what files 
to summarize when creating the feed. 
You can set this up any number of differ-
ent ways depending on what you would 
like to accomplish with your feed. The 
settings I’m going to outline here are 
best for summarizing a single page, like 
our home page or a blog-style page. Set 
the first popup to make a summary of a 
Page. Then you need to tell it which page 
will be summarized - you could type in 
the file:// url for the page, but really what 
you’ll do is click the little folder icon to 
the right of the text field. You’ll be pre-
sented with a dialog box to select an html 
file — pick the index.html file in the root 
directory of the site (the home page) and 
click choose. Subdirectories only applies 
to directory summaries, not to files, so it 
should be turned off. You’ll want to add 
entries to the RSS feed for all changes 
to this file so set Capture changes to 
File Modifications. Enter the base url for 
the website you will be publishing to, 
it will be used to create the links in the 
RSS feeds (RSS feed links are full URLs 
because you never know where the feed 
will be republished). Set Max stories to 
30 because we don’t want the feed to 
contain more than 30 news entries — this 
is arbitrary, and just what I happened 
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to want when I created it. You can set it any way you like, or leave it blank and 

there will be no limit. Be warned, though, 
unlimited RSS feeds just keep accumulat-
ing content, which probably isn’t what 
you really want.
	 The third panel determines how 
the headline will be extracted from the 
html page. The headline was within a TD 
tag with a CSS style (called a CLASS) of 
HPStoryRevHead applied. The content 
of that table cell should be used as the 
headline of the story in the RSS feed. So 
set the Match Tag to be TD (its not case 
sensitive). Set the CLASS attribute to be 
HPStoryRevHead to further uniquely 
identify the item we want. Extract the Tag 
Content to be used as the headline.
	 The fourth panel determines how 
the story will be extracted from the html 
page, in a similar manner to the way 
that headlines are extracted from the 
page. The story was within a P tag with 
a CSS style of HPStoryContent applied. 
The content of that paragraph should be 
used as the story in the RSS feed. So set 
the Match Tag to be P. The paragraph to 
include follows the headline, so set the 
Location to After the Headline. Set the 
CLASS attribute to be HPStoryContent 
to further uniquely identify the item we 
want. Extract the Tag Content to be used 
as the story. You may alternatively specify 
a maximum length for the content in 
characters or words, but as the stories a 
pretty short blurbs already there really 
isn’t a reason to here. You also might 
want to strip any HTML tags from the 
story (like the P tag or BR tag). Some 
aggregators have problems rendering 
HTML content. Good ones will just ignore 
the tags, but bad ones will actually dis-
play the HTML tags.To be more compat-
ible you would want to check Strip HTML.
	 The fifth and final panel determines 
where the file is saved and in what RSS 
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format. Tell it where to save the RSS file 
you are creating — you could type in the 
file:// url for the page, but really what 
you’ll do is click the little folder icon to 
the right of the text field. You’ll be pre-
sented with a dialog box to save a file 
— go to the root directory and type in 
“indexfeed.rss” and click save (you can 
call it whatever you want, that’s just what 
I used, but you should end the file with 
RSS or XML). Then pick which version of 
the RSS format to use — Version 1.0 is 
the most popular, DreamFeeder supports 
0.9.X, 1.0 and 2.0. Older formats are more 
broadly compatible, but newer formats 
support dates and times for each story, 
and graphics for the feed. Finally, click the 
Save button and the RSS file will be cre-
ated and added to your list of feeds.
	 After completing these steps the file 
for your feed has been created. It is now 
listed in the list of RSS feeds. The list entry 
indicates that it has never been updated 
— that means that the feed doesn’t have 
any stories in it yet. Also, the entry lists 
that there is 1 new story to be processed 
(actually, 1 modified file to be processed, 
but who’s counting?).
	 To process/update the feed you can 
simply click the Update button and the 
settings you defined before will be used 
to identify and extract new content which 
will then be added to the feed. So try it 
out, select your feed from the list and 
click the process/update button. The RSS 
feed will now have content that you can 
examine in your favorite news reader.

Feeding the JobBank
	 Open the JobBank and take a look 
at it — it’s the jobbank.html file in the 
03_HumanResource directory. This page 
is just a listing of the pages that are in the 
JobBank directory, each page is a differ-
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ent entry offering a different job. We can 
list these same pages in an RSS feed auto-
matically. This is an example where each 
file is a single story, and we’ll be summa-
rizing all the files within a directory.
	 Open the any Job Description file and 
examine it. This content represents the 
story that we’ll want to collect for use in 
our RSS feed. The way we’ll collect this 
content is based on the HTML code used 
to layout the content. Take a close look at 
the content and notice a few things:
	 The headline is a H1 but it’s the same 
for all the pages, so it’s not a good head-
line — Job Announcement
	 The subhead is a H3 but it actually 
contains the relevant headline content.
	 The story content is in P tags, but 
there are multiple paragraphs that we’ll 
want to collect.
	 `Now based on what we just looked 
at you’ll be able to define a feed for this 
page and use those attributes to identify 
the content to extract from the page and 
put into the RSS feed. You’re going to go 
through the same feed creation process 
as before, but with slightly different set-
tings appropriate to this content.
	 Enter descriptive information about 
the RSS feed in the first panel. You will 
need to enter the Title of the feed. You 
will also need to enter a Description for 
the feed. You may optionally include a 
graphic or icon to be used to represent 
the feed.
	 Define the files to summarize in the 
second panel. Set the first popup to make 
a summary of a Directory. Then you need 
to tell it which directory will be sum-
marized - you could type in the file:// url 
for the page, but really what you’ll do is 
click the little folder icon to the right of 
the text field. You’ll be presented with a 
dialog box to select a directory — pick 
the JobBank directory. If we wanted to 
include subdirectories in our summary 
you would want to check it, but that 
doesn’t matter for this example because 
there are no subdirectories. You’ll want 
to add entries to the RSS feed for all 
new files so set Capture changes to File 

Creation. Enter the base url for the web-
site you will be publishing to, it will be 
used to create the links in the RSS feeds 
(RSS feed links are full URLs because you 
never know where the feed will be repub-
lished). Set Max stories to 30 because we 
don’t want the feed to contain more than 
30 job entries — this is arbitrary, and just 
what I happened to want when I created 
it. You can set it any way you like, or leave 
it blank and there will be no limit. Be 
warned, though, unlimited RSS feeds just 
keep accumulating content, which prob-
ably isn’t what you really want.
	 Setup headline extraction in the third 
panel. Set the Match Tag to be H3 (its not 
case sensitive). Extract the Tag Content to 
be used as the headline.
	 Setup story extraction in the fourth 
panel. Set the Match Tag to be P (its not 
case sensitive). The paragraphs to include 
follow the headline, so set the Location 
to After the Headline. Set Extract the All 
Matching Tags to be used as the story 
content. That means multiple paragraphs 
will be collected. Finally limit the length 
of the story because multiple paragraphs 
might be a lot of text. Set Max Length to 
200 words.
	 In the fifth and final panel save your 
new feed.I saved it as “jobbank.rss” right 
next to the jobbank.html file.
	 After completing these steps the file 
for your feed has been created. It is now 
listed in the list of RSS feeds. The list entry 
indicates that it has never been updated 
— that means that the feed doesn’t have 
any stories in it yet. So process it and then 
test the results.

Linking to the Feeds
	 The last step in setting up your feeds 
is to link to them. You can do it the 
same way that you link to any file with 
Dreamweaver, but that only creates rela-
tive links, not Feed:// protocol links, and 
does not provide alternative content 
header links — which is how Safari knows 
to display the little RSS icon in the loca-
tion bar, or how NetNewsWire knows 
where to find a feed when given a regular 
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URL. So there are some deficiencies in the 
way that Dreamweaver treats linking to 
an RSS feed. RSS DreamFeeder provides 
an interface in the Link panel to address 
these issues (you may need to make the 
panel wider to see the Apply buttons — 
I’d have done it for you but Dreamweaver 
doesn’t allow it).
	 The panel is broken into two group-
ings: Alternative Content Link and 
Hypertext Link.
	 Alternative Content Link settings 
provide the way to setup the header links 
to the feed as an alternative to display-
ing HTML. If an aggregator see the page 
it will load the Feed instead of the page. 
The Link To popup menu allows you 
to select from the RSS feeds you have 
already created without having to select 
the file itself. Click the Apply button to 
apply your setting to the current page 
being edited. You can only have one RSS 
feed alternative per page, so any changes 
you make will modify that setting for the 
page.
	 Hypertext Link settings insert a 
hypertext link at the selection in the 
current document. The Link To popup 
menu allows you to select from the RSS 
feeds you have already created without 
having to select the file itself. To change 
the graphic click on it. You will be pre-
sented with a new popup menu where 
you can select a different graphic. Upon 
selection that graphic will be displayed. 
To use the Feed:// protocol check the 
box. This alternative protocol is asso-
ciated with RSS feeds so that news 
aggregators can be triggered as helper 
applications from within a web browser. 
Click the Insert button to insert your 
link.
	 So to link to our feed for the JobBank 
open the JobBank file, then click on the 
Link button in the RSS DreamFeeder 
panel. Set the alternative content to point 
to your JobBank feed. Then click on the 
page in front of open jobs and insert a 
Feed protocol link to the same feed. Click 
after the newly inserted link and press 
return to put the headline on a new line.
	 To link to our feed for the home page 
we have to edit content that isn’t avail-
able within the file, but rather is only 
editable in the template. No problem, 
open the HomePageTemplate file (in the 
Templates directory), and setup your link 
and alternative content header.

	 When you save, Dreamweaver will 
prompt you to update the pages that the 
template is based on. Click OK and it will 
update the home page to include the 
new links.

Nothing is Perfect
	 There are a few final details with what 
you did.
	 First, the content that you created 
probably has the words “UNREGISTERED” 
in it somewhere. Until you register your 
version of RSS DreamFeeder it will con-
tinue to include that content in both the 
headline and the story. You can purchase 
a serial number for RSS DreamFeeder 
at http://www.rnsoft.com. Click on the 
“REGISTER” button at the bottom of the 
RSS DreamFeeder panel and enter the 
serial number there.
	 Second, the feed protocol hypertext 
links you inserted point to some website 
that doesn’t exist, so don’t expect them 
to work. If you did publish the feeds on 
your website and configured the Base 
URL part of the feed correctly it would 
work. But its good enough for this tuto-
rial.
	 Third, for single page summary feeds 
like the home page feed we created 
you’ll notice that the dates all say the 
same thing. They are listing the modi-
fied date of the file for each new entry. 
Since all 3 entries are new, all 3 are listed 
with the same modified date. If you put 
a new entry on the home page, and run 
it now, it’s date would be different from 
the others. Nothing a quick text-editing 
couldn’t fix, but to be fair, it isn’t quite 
right.
	 Fourth, for directory summary 
feeds like the job bank feed we cre-
ated, remember that we configured it to 
capture files are based on their creation 
dates. I duplicated a file and tried to 
edit it only to discover that by doing so I 
didn’t change its creation date. The solu-
tion is to open the file and do a Save As, 
which creates a whole new file.
	 That’s All Folks
	 I hope you found this tutorial useful, 
and I hope that you’ll get a lot of use out 
of RSS DreamFeeder.
	 Thanks for you support.

From Andy Carvin at Digital Divide: 

(http://www.digitaldivide.net/articles/view.

php?ArticleID=68)

“Alternative 
Content Link 

settings provide 
the way to setup 
the header links 

to the feed as 
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to displaying 
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ave you ever looked for miss-
ing remote server names, user 
names, and passwords? Have 
you ever tried to transfer a site 

definition to another system by copying 
the data stored in the Site Definition dia-
log box? If so, you probably discovered 
that it doesn’t work because the pass-
word is encrypted.

	 Tip: If you are not in a hurry, try my Get 

Dreamweaver FTP Password feature at 

my Web site (www.moredw.com/getPW.

php).

	 Fear of losing user names and pass-
words is but one reason to back up your 
site definitions. You should also back up 
your site definitions each time you add a 
new site or edit an existing site because 
your computer could crash and you 
might lose your data, or something could 
go wrong when you install an upgrade or 
update that causes you to lose your site 
definitions. Backing up your site defini-
tions also safeguards you against an occa-

sionally temperamental Dreamweaver 
installation that might “forget” your site 
definitions.

Requirements
	 To complete this tutorial you will need 
to install the following software and files:
level 2 subhead Dreamweaver 8
•	 Try: www.macromedia.com/cfusion/

tdrc/index.cfm?product=dreamweave
r&promoid=devcenter_tutorial_prod-
uct_090903

•	 Buy: www.macromedia.com/cfusion/
store/html/indexcfm?event=displaySt
oreSelector&keyword=dreamweaver&
promoid=devcenter_tutorial_dream-
weaver_090903

•	 MM-Exporter: http://mm-exporter.
joexx.de/

•	 Site Import Export extension 
(Dreamweaver 4/4.01): http://macro-
media.com/cfusion/exchange/index.
cfm#loc=en_us&view=sn106&viewNa
me=Exchange%20Search%20Details&a
uthorid=60639501&page=0&scrollPos
=0&subcatid=0&snid=sn106&itemnum
ber=4&extid=157851&catid=0

Getting Started
	 As a Dreamweaver user, you have the 
following options to back up your site 
definitions. You can:
•	 Use the Dreamweaver export and 

import feature (available for Windows 
and Mac users)

•	 Back up the registry key (Windows 
users)

•	 Back up the Site Prefs file in the Sites 
folder (Mac users)

•	 Use the MM-Exporter extension 
(Windows user)

	 Note: This extension currently does not 

recognize Dreamweaver 8. An updated 

version will be available in early 2006.

	 Tip: Always print out and store every-

thing that contains the remote server 

access data, even if you are a paperless 

office fan!

Considering the Number of 
Sites
	 Your back-up strategy also depends 
upon the number of site definitions you 
want to back up. For a single site defini-
tion or a small number of site definitions, 
the best way is to use the export and 
import functions of the Dreamweaver 
site manager. If you have to back up 
many site definitions at the same time, 
you might be better off working with the 
Dreamweaver Sites registry key (Windows 
users) or back up the Site Prefs file (Mac 
user).

Transferring Site Definitions 
Between Platforms
	 The only way to transfer site defini-
tions between Windows and Macintosh 
platforms is to use the export and import 
feature.

	 Note: Don’t forget to edit your site defi-

nitions after importing the site definitions 

on the new operating system. You’ll have 

to point the site folder to the correct local 

folder where all the site’s files are stored!

Using the Dreamweaver 
Export/Import Feature
	 One easy and fast way to back up a 
site definition is to use the built-in export 
and import feature in Dreamweaver. 
This built-in function is available in 
Dreamweaver MX, Dreamweaver MX 

Backing Up Site Definitions in 
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2004, and Dreamweaver 8. Dreamweaver 
4 users must download and install a spe-
cial extension, Site Import Export.

	 Note: The export feature backs up only 

the site definition. It does not back up your 

site’s files. You have to do that manually!

Exporting Site Definitions in 
Dreamweaver 4
	 Dreamweaver 4 doesn’t have a native 
import and export feature. Instead, 
you have to use a special extension for 
exporting and importing site definitions.
1	 Download and install the Site Import 

Export extension for Dreamweaver 
4/4.01 (http://macromedia.com/cfu-
sion/exchange/index.cfm#view=sn106
&viewName=Exchange%20Search%20)

2	 To export a site definition, choose File 
> Export > Export Site.

3	 To import a site definition into 
Dreamweaver 4, choose File > Import > 
Import Site. After importing a site defi-
nition you must shut down and restart 
Dreamweaver before the imported site 
appears in Dreamweaver.

	 Note: The Site Import Export extension 

is not compatible with Dreamweaver MX/

MX2004/8. These versions have a built-in 

export and import feature. Dreamweaver 

4 does not recognize STE files used in 

Dreamweaver MX and later. Therefore, 

you cannot import a site definition export-

ed from Dreamweaver 4 into a newer 

Dreamweaver version. However, when you 

install Dreamweaver MX, Dreamweaver 

MX2004, or Dreamweaver 8, your exist-

ing Dreamweaver 4 and UltraDev site 

definitions will be imported automatically 

into the newer version of Dreamweaver. 

In short, do not uninstall Dreamweaver 

4 before installing a newer version of 

Dreamweaver.

Exporting Site Definitions 
in Dreamweaver MX/MX 
2004/8
	 To export site definitions in 
Dreamweaver MX/MX 2004/8, follow 
these steps:
1	 Choose Site > Edit Sites (Dreamweaver 

MX) or Site > Manage Sites 
(Dreamweaver MX 2004/8) to access 
the site manager. Alternatively, in 
Dreamweaver MX 2004/8, you can also 
select Manage Sites from the pop-up 

list in the Files panel to access the Site 
Manager (see Figure 1).

2	 Highlight the site name you want to 
export and click Export (see Figure 2).

3	 In the Export Site dialog box, Select 
the “Back up my settings” option and 
click OK (see Figure 3).

4	 Save the SiteName.ste file.

	 Tip: Use the name of the site for the 

SiteName so that you can recognize it 

easily later when you want to import it.

	 When you export a site definition, 
Dreamweaver writes the settings into an 
XML file with an STE extension. Do not 
change, add, or remove anything in that 
file!

Importing a Site Definition 
File
	 To import a Site Definition file, follow 
these steps:
1	 Open the Manage Sites window.
2	 Click the Import button (see Figure 4).
3	 Dreamweaver adds a new site name 

called Unnamed Site 1 to the list. This 
is a placeholder for the name of the 
site you want to import (see Figure 5).

4	 Navigate to the STE file you want 
to import, select it, and click OK. It 
might take a few seconds until your 
imported site name appears in the list. 
The imported site’s name will replace 

Unnamed Site 1.
5	 Click Done to save the new extended 

list and to close the Manage Sites win-
dow.

	 Note: Always use the Done button. 

Dreamweaver can behave strangely if you 

leave the Manage Sites window using the 

X in the upper right corner!

Backing Up the Registry 
Key (Windows Users)
	 If you are on Windows and you want 
to back up all of your site definitions in 
one single step, export the registry key 
that contains all of your site definitions 
and settings.
	 To export the registry key for your site 
definitions, follow these steps (Caution: 
Do not to change, add, or delete anything 
in the Windows registry!):
1	 Select > Start > Execute.
2	 Type regedit into the dialog box and 

click Execute to open the Registry edi-
tor.

3	 In the left-side window navigate to:
•	 Dreamweaver 4 users:
	 HKEY_CURRENT_USER\Software\

Macromedia\Dreamweaver 4\Sites
•	 Dreamweaver MX users:
	 HKEY_CURRENT_USER\Software\

Macromedia\Dreamweaver 6\Sites
•	 Dreamweaver MX 2004 users:
	 HKEY_CURRENT_USER\Software\
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Macromedia\Common\2004\Sites
•	 Dreamweaver 8 users:
	 HKEY_CURRENT_USER\Software\

Macromedia\Common\8\Sites

4	 Highlight the Sites key (see Figure 6).
5	 Select File > Export in the menu bar.
6	 Select Selected branch in the Export 

Range section of the Export Registry 
File dialog box.

7 	 Choose a name you can easily remember. 
(Tip: I always add the month and year 
to a file’s name. For example, sitesDW8_
11_05.reg for the sites definition key in 
Dreamweaver 8, saved in November 2005. 
This way, I always know when I backed up 
of the Sites registry key.)

8 	 Click Save to save your site definitions 
as a Registration File (*.reg).

	 To import and restore the Sites key in 
the registry, follow these steps:
1 	 Open the Registry editor.
2 	 Select > File > Import.
3 	 Go to the folder where you stored 
your REG file and click Import. The 
registry editor automatically imports 
the key to the correct place in the 
registry.

	 Alternatively, double-click the REG 
file. It will be automatically imported to 
the correct place in the registry.

	 Note: The imported registry key over-

writes the existing key. If you have added 

new site definitions since you backed 

up the registry key, you will lose the new 

definitions. Also, if you removed some 

site definitions, those definitions will be 

written to the registry again. To avoid 

any problems, always back up new site 

definitions using the export/import fea-

ture. To remove site names of sites that 

you have already deleted from the list, 

go to the Manage Sites window. Never 

change anything within the Sites key in 

the Registry!

	 Also, do not import old registry 
keys after installing a newer version of 
Dreamweaver. The newer version will 
automatically import the old site defini-
tions.

Backing Up the Site Prefs 
File in the Sites Folder (Mac 
users)
	 On Mac OS X, the site definitions are 
stored in the preferences. On OS X (as a 
multi-user OS) there is one Prefs file for 
the installation, and one for each user 
using Dreamweaver. Back up the file, 
which you can find at the following loca-
tions:
•	 Dreamweaver 4 users:
	 users/<user>/Library/Preferences/

Dreamweaver/Preferences
•	 Dreamweaver MX users:
	 users/<user>/Library/Preferences/

Dreamweaver MX Prefs
•	 Dreamweaver 2004
	 users/<user>/Library/Preferences/

Dreamweaver MX 2004 Prefs
•	 Dreamweaver 8 users:

	 users/<user>/Library/Preferences/
Dreamweaver 8 Prefs

	 To back up the file, make a back-up 
copy and store it on a safe place. Do not 
change, add, or remove anything in that 
file!

How To Restore Site 
Definitions
	 To restore your site definitions, copy 
the Site prefs file back into the prefs 
folder.

	 Note: This will work only if you did not 

change anything like path to the sites, site 

names, etc.

	 Tip: Also on a Mac, the best and safest 

way to back up site definitions is to use 

Dreamweaver’s export/import feature! In 

this way, Dreamweaver creates the STE, 

which you can import into Dreamweaver 

on other Macs and Windows too.

Where to Go from Here
	 In this article, you learned how 
to back up your site definitions in 
Dreamweaver. For more information, 
check out the following resources:
•	 Get Dreamweaver FTP Password fea-

ture on my Web site: www.moredw.
com/getPW.php

•	 MM-Exporter: http://mm-exporter.
joexx.de/

•	 Site Import Export extension (for 
Dreamweaver 4/4.01 users): http://
macromedia.com/cfusion/exchange/
index.cfm#loc=en_us&view=sn106&vie
wName=Exchange%20Search%20Deta
ils&authorid=60639501&page=0&scroll
Pos=0&subcatid=0&snid=sn106&itemn
umber=4&extid=157851&catid=0

•	 Dreamweaver Best Practices: http://
macromedia.com/devnet/dreamweav-
er/best_practices.html

Jolantha Belik is the author of 

Dreamweaver 8 – CSS, Templates, 

Dynamische Seiten, written in German. 

She also recorded a Video training on 

Dreamweaver 8. She runs her own com-

pany, jbel’s design, in Vienna, Austria. It 

offers Web site development and software 

training, especially coaching “woman to 

woman.” Jolantha is a Team Macromedia 

member and has published several tutori-

als for beginners at moreDW. www.jbels-

design.com
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lthough “Although SWF is not 
an open standard like SVG, 
Macromedia has been forth-

right in making SWF accessible to every-
one, even competing software vendors”
	 In a major repositioning effort in June 
of 2005, Macromedia unveiled the “Flash 
Platform.” 
	 The conception of Flash, the company 
had decided, needed to change: Flash 
had evolved from a tool for designers 
to an interoperating set of technologies 
appropriate for web application develop-
ment. The time had come for Macromedia 
to abandon Flash’s winsome singularity 
and start talking in terms of solutions 
rather than products. 

The OSFlash Initiative
	 Around the same time, a group of 
developers was working to bolster Flash’s 
support as a platform in a different way. 
The Flash development community had 
already produced a significant amount 
of tools that were open source, and it 
seemed due time to provide a way to 
centralize and organize those projects. 
	 Aral Balkan, respected Flash devel-
oper, author, and instructor, set out 
to champion such an initiative. With 
the assistance and support of like-
minded developers (in particular Nicolas 
Cannasse, author of MTASC, and Sonke 
Rohde) Aral created OSFlash.org (http://
OSFlash.org) as a much-needed home 
for the Open Source Flash development 
community.
	 OSFlash was explosive. At this writing, 
OSFlash is host to more than thirty open 
source Flash projects. Aside from provid-
ing these projects with a place to call 
home, OSFlash offers project-based mail-
ing lists, project management tools, and 

a presence on the OSFlash wiki. OSFlash 
also provides a general mailing list where 
developers can commune, brainstorm, 
and discuss new project ideas.
	 As the Flash Platform matures, the 
presence of a dynamic, spirited com-
munity of developers could be one of 
the most important factors in its success. 
With its Macromedia Labs site (http://labs.
macromedia.com), Macromedia has 
already made a commitment to involv-
ing developers in the retooling of Flash 
as a platform. Undoubtedly, developers 
will be a major driving force in the Flash 
Platform’s success. 

From Open Format to Open 
Source
	 The SWF file format, much like 
Adobe’s PDF format, is open. Macromedia 
publishes its “SWF File Format 
Specification” with each new version of 
the format. This document and its accom-
panying license are intended to “aid in 
the creation of software which creates 
SWF files.” 
	 Although SWF is not an open stan-
dard like SVG, Macromedia has been 
forthright in making SWF accessible to 
everyone, even competing software ven-
dors (see: Adobe LiveMotion.) The role of 
SWF as an open format is undoubtedly 
a large factor in its success as well as the 
feasibility of many of the open source 
solutions in discussion. Thus, we can 
draw the conclusion that an open format 
enables open source. The question that 
remains, however, is: does open source 
enables the growth of the Flash Platform?
	 Open source must in some way 
present itself as a bit of a dichotomy to 
Macromedia. It’s generally accepted that 
open source solutions foster innovation 

and adoption. However, with an open file 
format and a free player, is it possible that 
some projects could eventually challenge 
Macromedia’s own role by creating com-
peting tools? 
	 Several projects that provide “alterna-
tives” to Macromedia products come to 
mind. OpenAMF is an open source alter-
native to Flash Remoting for Java and 
started as a port of the more innocuous 
AMF-PHP. OpenLaszlo employs a similar 
methodology for creating SWF appli-
cations as Flex, and the nascent Red5 
project aims to provide a server product 
which provides some of the same func-
tionality as Flash Media Server. John 
Grden, Red5’s project manager, com-
mented: “We’d like to get the community 
more involved in the types of features 
offered by Flash Media Server and make 
them available to third world countries, 
non-profits, and others who might not 
otherwise take a look at Flash. That helps 
the Flash Platform by getting more devel-
opers into the fold of doing these types 
of applications.”
	 With Macromedia at the helm of the 
SWF file format and the ActionScript lan-
guage, it seems unlikely that any of these 
OS  tools could replace the Macromedia 
offerings. In fact, the vast majority of the 
open source projects leaders surveyed 
regarded their projects as complemen-
tary rather than competitive. Edwin can 
Rijkom, author of Screenweaver, went 
as far as to call Macromedia his “mother-
ship.” Even Grden, whose project could be 
viewed as competitive with Flash Media 
Server, doesn’t believe that his team is 
building an FMS replacement: 
	 “We’re pro Macromedia people; we’re 
not anti Macromedia people by any 
stretch of the imagination. I don’t know 
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that we’ll get their blessing so to speak, 
but we do hope that they’ll see the value 
and the void that I think it’s going to fill.”
	 Darron Schall’s view of Macromedia’s 
stance on open source is as follows: 
	 “The momentum behind OSFlash 
right now is a testament to the growth 
of the Flash Platform and lets businesses 
feel more comfortable relying on the 
Flash Platform… Macromedia overall 
has been very supportive of open source 
projects since it helps them establish 
the Flash Platform in the marketplace. 
The biggest conflict of interest that I 
see would be if open source developers 
were competing with Macromedia on a 
tool level.  That is, I doubt Macromedia 
would support an open source Flash IDE 
replacement. “
	 Balkan draws an interesting parallel to 
the success of Java: “As a platform, Flash 
has to be more than just a single technol-
ogy that is tightly controlled by one com-
pany. Take, for example, an established 
platform like Java. The Java VM is not 
open source and yet Java has probably 
one of the largest and most active open 
source communities of any platform. A 
multitude of servers, frameworks and 
tools, both open-source and closed-
source, co-exists happily in the Java world 
and there is no reason why they cannot 
in the Flash world. “
	 Tools like Flashout, ASDT, MTASC, 
Eclipse, and Swfmill (collectively referred 
to as FAMES) allow developers to create 
Flash applications without using any 
commercial Macromedia tools. Most 
developers using these tools see them as 
an enhancement to workflow rather than 
a replacement for the Flash IDE. Another 
benefit of such tools might be that they 
are a “safety net” – an assurance that non-
commercial methods exist to create Flash 
applications.
	 When asked if open source had the 
potential to draw developers to the Flash 
Platform, Balkan replied: 
	 “I know for a fact that the Open 
Source Flash initiative has attracted non-
Flash developers and developers who 
might not otherwise have considered 
Flash to the Flash Platform. In fact, at the 
Open Source Flash Panel at Spark Europe, 
an engineer from the BBC’s Research and 
Development department told the audi-

ence how their department only allowed 
her to use Flash for a project after she 
presented them with the projects on 
OSFlash and how they have now added 
Flash to their toolset. This is big: It’s an 
example of how Open Source Flash helps 
bridge the gap between the Flash world 
and the greater web development com-
munity.”
	 Cannasse also sees open source as an 
enabler: “I think people need alternatives. 
Macromedia is very good at focusing on 
medium and big business, but they can’t 
focus on everything at the same time. 
When they come up with a solution, it’s 
very difficult to make it financially acces-
sible to everyone. One of our goals is to 
provide software to those other organiza-
tions so they can use Flash where they 
couldn’t before.”
	 Although Macromedia hasn’t taken 
an official stance on many of the Flash-
related open source projects, it does 
seem supportive. OSFlash even hosts 
the JavaScript Integration Kit, which 
was authored by none other than Mike 
Chambers of Macromedia. Tim O’Reilly, 
founder, chairman, and CEO of O’Reilly 
Media and a strong advocate of open 
source, sits on the Macromedia board 
and describes his role as “bringing 
Macromedia the open systems/open 
source perspective.”

Round-Up of FlashOS 
Initiatives
Macromedia, Eclipse and Flex 

Builder 2

	 In June of 2005, Macromedia made 
a commitment to enabling developers 
to use Eclipse for ActionScript develop-
ment and joined the Eclipse Foundation. 
Macromedia’s new commercial IDE, 
Macromedia Flex Builder 2, is built on top 
of the open source Eclipse platform. 

MTASC and ASDT

	 Two projects which have attracted a 
lot of attention from the Flash develop-
ment community are MTASC and ASDT. 
	 MTASC (Motion-Twin ActionScript 2 
Compiler) is an open source ActionScript 
2 compiler which operates independently 
of the Flash IDE. When it was released, 
MTASC gained popularity not only 
because it was open source, but also 

because it could be integrated seamlessly 
with existing workflow in a way that the 
Flash IDE could not.
	 ASDT (ActionScript Development 
Tool) is a plugin for the Eclipse IDE, 
enabling developers to create and edit 
ActionScript files in a way they couldn’t 
before. Because Eclipse is a mature and 
standard editor, tools like ASDT (and the 
commercial Eclipse ActionScript plugin, 
FDT) allow developers to maintain their 
workflow. 
	 Since MTASC is a command line 
compiler it can also be integrated with 
Eclipse, and proves quite useful when 
used in conjunction with ASDT.
	 MTASC won’t be upgraded for 
ActionScript 3 support; instead, Cannasse 
is working on a new language called 
haXe (http://www.haxe.org).

FlashDevelop

	 For the developer looking for a 
straightforward editor, FlashDevelop is an 
open source solution that offers develop-
ers a simple, clean IDE with code comple-
tion and highlighting. MTASC can also be 
integrated with FlashDevelop. 

Red5

	 Since it was conceived of and started 
in August 2005, Red5 has been one of the 
most talked-about OSFlash projects. It 
aims to deliver an open source alternative 
to Macromedia Flash Media Server (FMS) 
– formerly Flash Communication Server. 
	 Red5 is currently in version .2, a proto-
type release. The Red5 team anticipates a 
1.0 release by the second quarter of 2006. 
Currently, Red5 can stream video to the 
Flash client and has also been used to 
push a live stream.
	 RTMP (Real Time Messaging Protocol) 
is a proprietary messaging protocol 
developed by Macromedia. RTMP is 
employed in Flash Media Server, and 
will also be used for messaging services 
in Flex Enterprise Services 2. In order to 
make Red5 work, the Red5 team had to 
reverse-engineer the RTMP protocol, a 
process which is explained in detail on 
the Red5 website.
	 One thing that’s not completely clear 
to the Red5 team is the legality of creat-
ing such a product. Project manager John 
Grden commented: “As far as legalities of 
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protecting the actual protocol, we don’t 
have an answer. We’ve been told that if 
we’re using a protocol for interoperability 
then we are fine within US law. However, 
we’ve been told by Macromedia that 
they have a right to protect what they’ve 
invested in, which would include FMS 
and RTMP. That doesn’t mean that they’re 
threatening us; I think that they’re try-
ing to decide what they’re going to do. I 
think one thing that’s clear is that they’re 
unprepared for open source, and Red5 
has caught them a little bit off guard.”
	 Grden stressed that Red5 was not a 
“replacement” for Flash Media Server: 
“FMS has edge and origin servers and 
tools for enterprise deployments. We 
have plans for that, but that’s beyond 1.0. 
Right now we’re just trying to come out 
with a server that does the basic things 
that FMS does.”

Frameworks: ARP and Cairngorm

	 ARP and Cairngorm are two examples 
of pattern based frameworks for Flash 
development. 
	 ARP, developed by OSFlash coordina-
tor Aral Balkan, is appropriate for Flash or 
Flex development. Like Cairngorm and 
other frameworks, ARP provides a core 
set of lightweight classes to aid in design 
pattern based development.
	 Cairngorm is a framework for Flex 
application development, and has some 
commonalities with ARP. Cairngorm was 
developed by iteration::two (recently 
acquired by Macromedia). Alistair 
McLeod, RIA Practice Director (EMEA) at 
Macromedia and Cairngorm developer, 
noted that one key benefit of Cairngorm 
is the employment of accepted patterns. 
Cairngorm may be especially useful for 
Java developers who are transitioning to 
Flex. 
	 “Cairngorm is based upon the design 
patterns used by Java enterprise develop-
ers and this makes it much easier for Java 
developers to reach across the divide into 
the Flash platform. We have already seen 
substantial evidence from clients that this 
framework has made it much easier for 
their enterprise Java developers to start 
working with Flex,” said McLeod.
	 Balkan and McLeod both agree that 
the choice between ARP and Cairngorm 
depends on the project and the develop-

ers involved, and that in some cases a 
framework may not be appropriate at all.

ActionStep Component Framework

	 ActionStep is a project worth watch-
ing. Although not currently in a final 
release, the ActionStep team has made 
some interesting accomplishments in cre-
ating an open source component frame-
work for Flash.
	 ActionStep is based on the OpenStep 
API specification created by NeXT which 
was later purchased by Apple. Developers 
familiar with Cocoa or GNUstep will have 
an easy time picking up ActionStep and 
diving into Flash development.
	 ActionStep promises some very 
exciting features, including layout com-
ponents, a declarative layout language 
called ASML (a la MXML, XUL, or XAML), 
and simplified skinning. The ActionStep 
team, comprising Scott Hyndman, 
Richard Kilmer and Ray Chuan, antici-
pates that a beta release of ActionStep 
will be available for the New Year.

Screenweaver: Open Source Flash 

on the Desktop

	 Screenweaver started as a commercial 
project, but was later released as an open 
source project. Currently, Screenweaver 3 
can be used to create Windows applica-
tions with SWF content.
	 An interesting development is the 
Screenweaver 4 project. Screenweaver 
4 represents a shift away from the 
typical “SWF2EXE” approach and instead 
attempts to provide a toolkit for develop-
ers looking to create desktop applications 
that use Flash for the presentation tier. 
	 On the difference between 
Screenweaver 3 and Screenweaver 4, 
developer Edwin van Rijkom comments: 
“SW3 is aimed at Flash developers 
who want to create Windows desktop 
applications using Flash. It does so by 
bringing Windows operating system 
functionality to ActionScript. Using this 
model, all application logic is contained 
in Flash and written by the Flash devel-
oper. At a high level, the SW3 GUI tool 
also offers several wizards for quickly 
putting together relatively simple proj-
ects like screen savers or small desktop 
widgets. SW4 is a platform for traditional 
desktop application programmers who 

wish to deploy Flash as a GUI for their 
application. As a result SW4 consists of 
a set of libraries these developers can 
link to. Additionally, the SW4 platform 
offers tools that manage the workflow 
between the traditional coder, and the 
Flash designer/developer that will be 
responsible for creating the GUI.”
	 Screenweaver 4 is currently in Alpha 
release.  

AFLAX: Flash, Sans ActionScript

	 Developer Paul Colton recently 
released a toolkit which supports a 
technology he calls AFLAX. The AFLAX 
project provides a small “bootstrap” SWF 
file which can be interacted with through 
JavaScript. The project is presumably 
aimed at AJAX developers who wish 
to use Flash for the drawing and video 
without adopting ActionScript into their 
workflow.
	 Using the AFLAX toolkit, a developer 
can instantiate ActionScript objects 
and create graphical assets using pure 
JavaScript on the client side. The Aflax.
org website provides some compelling 
examples (most of which are ported from 
ActionScript examples) that are based 
completely in JavaScript.

But Wait, There’s More

	 As with any platform, the role of the 
developer community is essential to the 
success of the Flash Platform. When we 
look at the open source community sur-
rounding Flash, we see a dedicated group 
of developers working incredibly hard 
to create tools to shape the future of the 
Flash Platform. 
	 It just isn’t possible, in the ambits of a 
single MXDJ article, to cover all of the great 
projects that are going on in the open 
source Flash community right now. For a 
comprehensive list of these projects, or to 
get involved, visit the OSFlash.org website.

Jim Phelan is VP of Development 

at Stream57, a New York City firm 

specializing in creating Rich Internet 

Applications for live video events, vid-

eoconferencing, and e-learning. Jim, 
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Aral Balkan
BDFL, OSFlash.org

MXDJ: What is OSFlash?

Aral Balkan: OSFlash is home of the Open 
Source Flash community. It is a water-
ing hole for open source developers to 
meet, talk about and contribute to new 
and existing open source projects for the 
Flash Platform.  

Is OSFlash a website or is it an initiative?

AB: It’s an initiative, a closely-knit com-
munity, a resource and a platform. I see my 
own role as enabler; providing the tools 
and resources that our amazing commu-
nity of developers can use to weave their 
magic. Most of the time, I just sit back and 
gaze agape at the virtual sparks of creativ-
ity that fly across the vast ether of the 
Internet only to materialize in exciting new 
project s, usually within a matter of weeks 
or months. It is truly an honor to be in the 
midst of such creative talent.  

How do you see the OSFlash / Macromedia 
relationship?

AB: OSFlash and Macromedia have a 
symbiotic relationship. The existence of 
a strong, active Open Source Flash com-
munity is a primary legitimizing factor 
for the Flash Platform. We both believe 
that the Flash Platform holds amazing 
promise in the age of Web 2.0 and we are 
both passionate about seeing the Flash 
Platform succeed, both today and long 
into the future.

Why do you write open source software?

AB: Because it is fun! Because there is no 
bureaucracy involved. Because what you 
write is immediately useful, both to your-
self and to others (it scratches an itch). 
Because you can see it grow beyond what 
you could have imagined for it yourself. 
Because it can help others. 

Nicolas Cannasse
Author of MTASC

MXDJ: What is MTASC?

NC: MTASC is an open source Actionscript 
2 compiler.

What made you decide to invest your time 
in MTASC?

NC: Well, MTASC is not only a personal 
project; it’s sponsored by my company. 
We’ve been using open source tools like 
PHP and MySQL for years now, and we 
were able to start a company and do 
business because these tools were free. It 
might not have been possible to start our 
company if we had the expense of licens-
ing commercial software. So, after a few 
years, we decided it was time to give back 
to the community and allow other people 
to do these things using Flash.

Do open source tools like MTASC broaden 
the reach of the Flash Platform?

NC: I think so. A lot of people are com-
ing and try to use Flash, but they can’t 
because the Flash IDE is not available 
on Linux. There are a lot of people who 
are interested in Flash but haven’t been 
able to use it. Now, they can use Flash 
with open source tools. I think MTASC is 
popular because it addresses something 
that was missing. When you have a lot of 
libraries and source code, you need a fast 
compiler that supports your workflow. 

What about Flex Builder 2 and ActionScript 
3? Will MTASC support ActionScript 3?

NC: I won’t support Actionscript 3 in 
MTASC. I’m currently working on another 
project called haXe which opens a lot of 
new possibilities. haXe allows you to use 
the same language everywhere: for Flash, 
for the server side and for Javascript. 

Darron Schall
Application Developer, DarronSchall.

com

MXDJ: What is the one open source Flash 
project that all Flash developers should be 
aware of?

DS: I would say that there are two right 
now. MTASC is obviously the biggest 
one as it allows developers to compile to 
SWF without the need to purchase the 
Flash IDE.  MTASC fits the “traditional” 
developer workflow better than the Flash 
IDE, allowing programmers to write code 
in text files and invoke a command line 
compiler to spit out a binary.

“OSFlash and 
Macromedia have 

a symbiotic 
relationship. The 

existence of 
a strong, 

active Open 
Source Flash 
community is 

a primary 
legitimizing f
actor for the 

Flash Platform”

34 • mxdj.com 11 • 2005



	 The other is Red5.  This is an 
open source alternative to Flash 
Communication Server (now Flash Media 
Server) that has really made some great 
strides in the past month. The speed of 
which the project was organized to when 
it was “usable” was pretty incredible. It 
goes to show that when like-minded 
people focus with a task at hand, much 
can be accomplished.

What does the open source Flash commu-
nity have to offer to developers who are not 
currently building Flash applications?

DS: The Flash Platform offers a “write once 
run anywhere” model that actually works!  
Java proclaimed this, but we all know 
how fast it turned into “write once debug 
everywhere.” Seriously, Flash is everywhere 
and it’s only going to continue growing. 
Flash is not only cross-platform, but cross-
device, ranging from video game consoles 
to mobile phones to interfaces on digital 
cameras to running the interface in the 
new Jaguar XK. The open source commu-
nity gives developers a compiler in MTASC, 
a resource injector in Swfmill and an editor 
in ASDT to allow for deployment on the 
Flash Platform. I think these are the key 
projects in winning developers from other 
languages.

Why is open source important to the Flash 
Platform?

DS: Oddly enough, it seems most of my 
“open source Flash” projects fall in the 
tools category and were created in Java.  
I’ve always been jealous at the amount 
of tools available for other languages 
and have tried to re-create some of these 
same tools for ActionScript.  Having a 
good toolset makes it easier for develop-
ers to switch, and the more developers 
using Flash, the better it is for all of us.
	 Word about Flash is getting out, 
and in a big way. The new version of 
Enterprise Architect (version 6) supports 
Forward and Reverse Code Engineering 
of ActionScript 2.0. This is huge. It finally 
puts ActionScript 2.0 on the same level as 
Java and C#, something I’ve been trying 
to push for a long time.

Alistair McLeod
RIA Practice Director (EMEA), 

Macromedia

Formerly Technical Director at itera-

tion::two

MXDJ: What are Cairngorm and FlexUnit?

AM: Our architectural framework, 
Cairngorm, is based upon the design pat-
terns used by Java enterprise developers 
and this makes it much easier for Java 
developers to reach across the divide into 
the Flash platform. We have already seen 
substantial evidence from clients that this 
framework has made it much easier for 
their enterprise Java developers to start 
working with Flex.
	 Likewise, Java developers are used 
to unit testing with JUnit. With FlexUnit 
available to them, they can make them-
selves at home almost immediately in the 
Flex environment. 
	 With these two projects, we have 
found that we can get Java developers up 
to speed in our consultancy in a matter 
of weeks, rather than the months it might 
have taken.

Why are open source projects like 
Cairngorm and FlexUnit import to the Flash 
Platform?

AM: With the repositioning of Flash as a deliv-
ery platform for enterprise grade applications, 
developers are becoming used to having 
access to architectural frameworks such as 
Cairngorm and unit testing frameworks such 
as Flex Unit. The community has been able 
to quickly fill the gaps between the tools 
provided by Macromedia and in doing so 
Macromedia has been able to entice more 
software developers to their platform. 
 

iteration::two was recently acquired by 
Macromedia and is now Macromedia 
Consulting. Will that change the role of 
open source in your organization?

AM: All the consultants we have are pas-
sionate about software development, and 
understand the benefits of open source 
software. However, we’re still finding our 
feet as Macromedia Consulting, so it’s too 
early to tell.

We can announce, however,  that FlexUnit is 
currently being converted for use with Flex 
2 and will be hosted on Macromedia Labs 
in the near future to work alongside the 
Flex 2 release that is now in public alpha.

“With the 
repositioning 
of Flash as 
a delivery 
platform for 
enterprise grade 
applications, 
developers 
are becoming 
used to 
having access 
to architectural 
frameworks such 
as Cairngorm 
and unit testing 
frameworks such 
as Flex Unit”
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acromedia Flash Basic 8 
and Flash Professional 
8 offer several ways to 

include animation and special effects in 
your document. For example, you can 
create tweened animations using the 
Timeline and Flash workspace, automated 
Timeline effects (by making selections in 
a dialog box), or ActionScript code.
	 To create tweened animations, you 
create starting and ending frames and 
let Flash create the animation for the 
frames in between. Flash varies the 
object’s size, rotation, color, or other attri-
butes between the starting and ending 
keyframes to create the appearance of 
movement. You can also create animation 
by changing the contents of successive 
frames in the Timeline. You can make an 
object move across the Stage, increase 
or decrease its size, change its color or 
shape, rotate it, and even fade in or out. 
Changes can occur independently of, 
or in concert with, other changes. For 
example, you can make an object rotate 
and fade in as it moves across the Stage. 
In frame-by-frame animation, you create 
the image in every frame.
	 You have several options when creat-

ing tweened animations. You can create 
traditional frame-by-frame animations 
(see the section, Creating Frame-by-
Frame Animations, http://macromedia.
com/devnet/flash/articles/anima-
tion_guide_09.html), motion tweens (see 
Creating Motion Tweens, http://macro-
media.com/devnet/flash/articles/anima-
tion_guide_05.html), or shape tweens 
(see Creating Shape Tweens, http://mac-
romedia.com/devnet/flash/articles/ani-
mation_guide_07.html).
	 Timeline effects include animated 
vector effects such as blur, expand, and 
explode. This feature makes it easy to 
animate an object: you can simply select 
the object and then select an effect and 
specify its parameters. With Timeline 
effects, you can accomplish in a few easy 
steps a previously time-consuming task 
that required more advanced knowledge 
of animation.
	 You can also create an animation by 
writing ActionScript code, which is some-
times called scripted animation. There are 
different ways you can script animation: 
you can write ActionScript to handle all 
aspects of the animation or you can use 
prebuilt classes and simpler code to cre-

ate an animation. Using prebuilt classes 
makes animating with code quite easy.
	 Using code to create animations 
and effects often reduces the file size of 
your finished application, and can also 
improve the performance and consis-
tency of the animation itself. At times, 
ActionScript-based animations might 
even reduce your workload: code can be 
faster to write, and it’s easy to apply to 
many instances at once or reuse in other 
applications. The following sections intro-
duce you to scripted animation funda-
mentals, animation using the Tween and 
TransitionManager classes, and integrat-
ing animation with both the Drawing API 
and filter classes.

	 Note: For more information on filter 

effects, see the Flash Graphic Effects 

Learning Guide (http://macromedia.

com/devnet/flash/articles/graphic_effects_

guide.html).

Requirements
	 To make this most of this tutorial, you 
need to install the following software 
and files: Macromedia Flash Basic 8 or 
Macromedia Flash Professional 8

Prerequisite Knowledge
	 A basic knowledge of the Flash user 
interface.

About Frame Rate and 
Animation
	 The frame rate, the speed at which 
an animation is played, is measured in 
number of frames per second. A frame 
rate that’s too slow causes the animation 
to appear jerky; a frame rate that’s too 
fast might negatively affect the animation 
or use too much of the user’s computer 

Flash Animation Learning Guide

Part 1
by jen dehaan & chris georgenes
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processing power. The complexity of the 
animation and the speed of the computer 
on which the animation is being played 
affect the smoothness of the playback. 
Test your animations on a variety of 
machines to determine optimum frame 
rates.
	 You need to think about frame rate 
when working with animations because 
it can affect the performance of your 
SWF file and the computer that plays it. 
Setting a frame rate too high can lead to 
processor problems, especially when you 
use many assets or use ActionScript to 
create your animation. However, you also 
need to consider the frame rate setting 
because it affects how smoothly your ani-
mation plays.
	 For example, an animation set to 12 
frames per second (fps) in the Property 
inspector plays 12 frames each second. If 
the document’s frame rate is set to 24 fps, 
the animation appears to animate more 
smoothly than if it ran at 12 fps. However, 
your animation at 24 fps also plays much 
faster than it does at 12 fps, so the total 
duration (in seconds) is shorter. Therefore, 
if you need to make a five-second anima-
tion using a higher frame rate, it means 
you need to insert additional frames to fill 
those five seconds than at a lower frame 
rate—which raises the total file size of 
your animation. A five-second animation 
at 24 fps typically has a higher file size 
than a five-second animation at 12 fps, 
depending on your assets and how you 
are animating the content. 

	 Tip: Because you specify only one 

frame rate for the entire Flash document, 

it’s a good idea to set this rate before you 

begin creating the animation.

	 Note: When you use an onEnter-

Frame event handler to create scripted 

animations, the animation runs at the 

document’s frame rate, as if you created 

a motion tween on a timeline. An alterna-

tive to the onEnterFrame event handler is 

setInterval. Instead of depending on the 

frame rate, you call functions at a speci-

fied interval. Like onEnterFrame, the more 

frequently you use setInterval to call a 

function, the more resource-intensive the 

animation is on your processor.

	 Use the lowest possible frame rate 
that makes your animation appear to play 
smoothly at runtime because it will help 

reduce the strain on the end-user’s pro-
cessor. Try not to use a frame rate that’s 
more than 30–40 fps; high frame rates 
put a lot of stress on processors. Also, do 
not change the appearance of the anima-
tion much, or at all, at runtime.
	 Finally, especially if you’re working 
with Timeline-based animations, select 
a frame rate for your animation as early 
as possible in the development process. 
When you test the SWF file, check the 
duration and the SWF file size of your ani-
mation. The frame rate greatly affects the 
speed of the animation.

Creating Keyframes for 
Animations
	 A keyframe is a frame in which you 
define changes in the animation. When 
you create a frame-by-frame animation, 
most frames are keyframes. In a tweened 
animation, you define keyframes at sig-
nificant points in the animation and let 
Flash create the contents of the frames in 
between. Flash displays the interpolated 
frames of a tweened animation as light 
blue or light green and with an arrow 
drawn between keyframes. Because 
Flash documents save the shapes in each 
keyframe, you should create keyframes 
only at those points in the artwork where 
something changes.
	 Keyframes are indicated in the 
Timeline: A keyframe with content on it 
is represented by a solid circle; an empty 
keyframe is represented by an empty cir-
cle within the frame. Subsequent frames 
that you add to the same layer have the 
same content as the keyframe.
	 To create a keyframe, do one of the 
following:
• 	 Select a frame in the Timeline and 

select Insert > Timeline > Keyframe
• 	 Right-click (Windows) or Control-click 

(Macintosh) a frame in the Timeline 
and select Insert Keyframe

	 Tweens are placed on the Timeline. 
You can also place code that animates 
instances on the Timeline. The appear-
ance of your animation can differ, 
depending on the techniques you use to 
create your animation.
	 Motion tweens are indicated by a 
black dot at the beginning keyframe; 
intermediate tweened frames have a 
black arrow with a light blue background.
	 Shape tweens are indicated by a black 

dot at the beginning keyframe; interme-
diate frames have a black arrow with a 
light green background.
	 A dashed line indicates that the 
tween is broken or incomplete, such as 
when the final keyframe is missing.
	 A single keyframe is indicated by a 
black dot. Light gray frames after a single 
keyframe contain the same content with no 
changes and show a black line with a hol-
low rectangle at the last frame of the span .
	 A small a indicates that the frame 
has frame scripts assigned to it with the 
Actions panel .
	 A series of keyframes with a light gray 
background might indicate a frame-by-
frame animation.
	 A hollow circle represents a blank 
keyframe, and white frames represent 
frames with no content. This frame begins 
a section with no content on the layer. 
For example, if you have an instance that 
blinks on a layer, you might insert blank 
keyframes where you do not want the 
instance to appear.

Creating Tweened 
Animations
	 Flash can create two types of tweened ani-
mation: motion tweening and shape tweening.
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	 In motion tweening, you define prop-
erties such as position, size, and rotation 
for an instance, group, or text block at 
one point in time, and then change those 
properties at another point in time. After 
you do so, you can apply the motion 
tween between those two frames. Flash 
automatically creates the movement 
between the first and second point in 
time. You can also apply a motion tween 
and assign a path for it to follow. For 
more information on motion tweens, see 
the next section, Creating Motion Tweens.
	 In shape tweening, you draw a shape 
at one point in time, and then change 
that shape or draw another shape at 
another point in time. Flash interpolates 
the values or shapes for the frames in 
between, thus creating the animation. 
The shape morphs from the first shape 
into the second shape. For more informa-
tion on shape tweens, see the later sec-
tion, Creating Shape Tweens.
	 Note: To apply shape tweening to 
groups, instances, or bitmap images, you 
must first break these elements apart 
(Modify > Break Apart). To apply shape 
tweening to text, you must break the text 
apart twice to convert the text to objects.
	 Tweened animation is an effective 
way to create movement and changes 
over time while minimizing file size and 
development time. In tweened anima-

tion, Flash stores only the values for the 
changes between frames. To quickly 
prepare elements in a document for 
tweened animation, distribute objects to 
layers (Modify > Timeline > Distribute to 
Layers).

Creating Motion Tweens
	 To tween the changes in properties 
of instances, groups, and type, you use 
motion tweening. Flash can tween posi-
tion, size, rotation, and skew of instances, 
groups, and type. Additionally, Flash can 
tween the color of instances and type, 
creating gradual color shifts or making 
an instance fade in or out. To tween the 
color of groups or type, you must make 
them into symbols.
	 If you apply a motion tween and then 
change the number of frames between 
the two keyframes, or move the group 
or symbol in either keyframe, Flash auto-
matically tweens the frames again.
	 You can create a motion tween using 
one of two methods:
• 	 Create the starting and ending key-

frames for the animation and use 
the Motion Tweening option in the 
Property inspector.

• 	 Create the first keyframe for the anima-
tion, insert the number of frames you 
want in the Timeline, select Insert > 
Timeline > Create Motion Tween, and 

move the object to the new location 
on the Stage. Flash automatically cre-
ates the ending keyframe.

	 The animation has several layers. 
All of the assets of the bee are within a 
movie clip. Therefore, you can animate 
the instance on the main Timeline. Inside 
the instance, some elements (such as 
the wings) are movie clip instances with 
nested animations. The wings contain 
frame-by-frame animations.
	 When tweening a position, you can 
make the object move along a nonlinear 
path. To create a motion tween using the 
Motion Tweening option:
1	 Create a new file and call it motiont-

ween.fla.
2	 Select Frame 1 of Layer 1. This is where 

the animation will start.
3	 Create a graphic with the Pen, Oval, 

Rectangle, Pencil, or Brush tool. Select 
it and then choose Modify > Convert 
to Symbol.

4	 In the Convert to Symbol dialog box, 
make sure the Movie Clip option is 
selected and then click OK. Now the 
graphic you created is an instance 
on the Stage (with a symbol in the 
Library).

5	 Select Frame 10 on Layer 1 and then 
press F6 to create a second keyframe. 
This is where the animation will end.

6	 Select your instance on the Stage at 
Frame 10. Do any of the following to 
modify the instance:
•	 Move it to a new position on the 

Stage.
•	 Modify the item’s size, rotation, or 

skew using the Free Transform tool.
7	 Click any frame in the tween’s frame 

span (for example, select Frame 5 of 
Layer 1) and select Motion from the 
Tween pop-up menu in the Property 
inspector (Window > Properties > 
Properties).

8	 With the frame still selected, drag 
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“To tween the changes in properties of 
instances, groups, and type, you use 

motion tweening. Flash can tween 
position, size, rotation, and skew of 

instances, groups, and type”
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the arrow next to the Easing value 
in the Property inspector (Window 
> Properties > Properties) or type in 
a value to adjust the rate of change 
between tweened frames.

	 Note: By default, the rate of change 
between tweened frames is constant. 
Easing creates a more natural appear-
ance of acceleration or deceleration by 
gradually adjusting the rate of change.

9	 To rotate the selected item while 
tweening, select an option from the 
Rotate menu:
•	 Select None (the default setting) to 

prevent rotation
•	 Select Auto to rotate the object 

once in the direction requiring the 
least motion

•	 Select Clockwise (CW) or 
Counterclockwise (CCW) to rotate 
the object as indicated, and then 
enter a number to specify the num-
ber of rotations

	 Note: The rotation in Step 9 is in addi-

tion to any rotation you applied to the end-

ing frame in Step 6.

10	.	`Select Control > Test Movie to test 
the animation.

Applying Easing and 
Custom Ease-in and Ease-
out to Motion Tweens
	 The term easing refers to gradual 
acceleration or deceleration during an 
animation, which helps your animations 
appear more realistic. Easing creates a 

more natural appearance of acceleration 
or deceleration by gradually adjusting the 
rate of change.
	 To produce a more realistic sense 
of motion, you can apply easing to the 
motion tween you create. Flash provides 
two methods by which you can apply eas-
ing to a motion tween: You can specify an 
easing value for each motion tween you 
create using the Ease slider, or you can 
use the Custom Ease In/Ease Out dialog 
box (Flash Professional only) to control the 
speed of the motion tween more precisely.
	 To apply regular easing to a motion 
tween:
1	 Create a new file and call it motio-

nease.fla.
2	 Select Frame 1 of Layer 1. This is where 

the animation will start.
3	 Create a graphic with the Pen, Oval, 

Rectangle, Pencil, or Brush tool. Select 
it and then choose Modify > Convert 
to Symbol.

4	 In the Convert to Symbol dialog box, 
make sure the Movie Clip option is 
selected and then click OK. The graphic 
you created is an instance on the Stage 
(with a symbol in the Library).

5	 Select Frame 10 on Layer 1 and then 
press F6 to create a second keyframe. 
This is where the animation will end.

6	 Select your instance on the Stage at 
Frame 10. Do any of the following to 
modify the instance:
•	 Move it to a new position on the 

Stage.
•	 Modify the item’s size, rotation, or 

skew using the Free Transform tool.

7 	 Click any frame in the tween’s frame 
span (for example, select Frame 5 of 
Layer 1) and select Motion from the 
Tween pop-up menu in the Property 
inspector (Window > Properties > 
Properties).

8	 With the frame still selected, drag 
the arrow next to the Easing value 
in the Property inspector (Window 
> Properties > Properties) or type in 
a value to adjust the rate of change 
between tweened frames:
•	 To begin the motion tween slowly 

and accelerate the tween toward 
the end of the animation, drag the 
slider up or enter a negative value 
between –1 and –100.

•	 To begin the motion tween rapidly 
and decelerate the tween toward 
the end of the animation, drag the 
slider down or enter a positive value 
between 1 and 100.

	 Note: By default, the rate of change 

between tweened frames is constant. 

Easing creates a more natural appearance 

of acceleration or deceleration by gradu-

ally adjusting the rate of change.

9	 Select Control > Test Movie to test the 
animation. The SWF file shows regular 
easing (the top bee) and customized 
easing (the bottom bee). The vertical line 
that animates from left to right has no 
easing applied.
	 Custom easing enables you to con-
trol these elements through an intuitive 
graph that provides independent control 
over the position, rotation, scale, color, 
and filters used in a motion tween. When 
you create a motion tween and then 
select it in the Timeline, you can click 
a button labeled Edit to customize the 
motion tween.
	 The Custom Ease In/Ease Out dialog 
box displays a graph representing the 
degree of motion over time. Frames are 
represented by the horizontal axis and 
the tween’s percentage of change is 
represented by the vertical axis. The first 
keyframe is in the animation is at 0% and 
the last keyframe is at 100%. The rate of 
change of the tweened instance is shown 
by the slope of the graph’s curve. If you 
create a horizontal line (no slope) on the 
graph, the velocity is zero; if you create 
a vertical line on the graph, there is an 
instantaneous rate of change.

fi
g

u
re

 4

40 • mxdj.com 11 • 2005



	 To open the custom easing dialog 
box:
1	 Create a motion tween, as described in 

the first example in this section.
2	 Click any frame in the tween’s frame 

span and select Motion from the 
Tween pop-up menu in the Property 
inspector (Window > Properties).

3	 Click the Edit button (next to Ease) in 
the Property inspector to open the 
Custom Ease In/Ease Out dialog box.

	 The dialog box provides the following 
additional controls:
•	 Use One Setting for All Properties 

check box: The default value for this 
is selected, which means that the dis-
played curve is used for all properties 
and the Properties pop-up menu is 
disabled. When the check box is not 
selected, the Properties pop-up menu 
is enabled and each property has a 
separate curve defining the velocity of 
that property.

•	 Property pop-up menu: This menu 
is enabled only when the Use One 
Setting for All Properties check box is 
not selected. When enabled, a separate 
curve is maintained for each of the 
five properties appearing in the menu. 
Selecting a property in the menu dis-
plays the curve for that property. The 
properties are as follows:

•	 Position: Specifies custom ease settings 
for the position of an animated object 
on the Stage.

•	 Rotation: Specifies custom ease set-
tings for the rotation of an animated 
object. For example, you can fine-tune 
how quickly or slowly an animated 
character turns around to face the user 
on the Stage.

•	 Scale: Specifies custom ease settings 
for the scale of an animated object. For 
example, you can customize the scale 
of an object more easily so it appears 

to be moving away from the viewer, 
then coming closer, and then moving 
away again.

•	 Color: Specifies custom ease settings 
for color transitions applied to an ani-
mated object.

•	 Filters: Specifies custom ease settings 
for filters applied to an animated 
object. For example, you can control 
the ease setting of a drop shadow that 
simulates a change in the direction of a 
light source.

•	 Play and Stop buttons: These buttons 
enable you to preview an animation on 
the Stage using all the current veloc-
ity curves defined in the Custom Ease 
In/Ease Out dialog box.

•	 Reset button: This button enables 
you to reset the velocity curve to the 
default, linear state.

•	 Position of the selected control point: 
In the lower-right corner of the dialog 
box, a numeric value displays the 
keyframe and position of the selected 
control point. If no control point is 
selected, no value appears.

	 To add a control point to the line, click 
the diagonal line once. This adds a new 
control point to the line. By dragging the 
positions of the control points, you can 
achieve a precise degree of control over 
the motion of an object.
	 Using frame indicators (represented 
by square handles), you click where you 
want an object to slow down or speed 
up. Clicking the handle of a control point 
(the square handles) selects that control 
point and displays the tangent points on 
either side of it. Tangent points are rep-
resented by hollow circles. You can drag 
the control point or its tangent points 
with the mouse or you can position them 
using the keyboard’s arrow keys.

	 Tip: By default, the control points snap 

to a grid. You can turn off snapping by 

pressing the X key while dragging the con-

trol point.

	 Clicking an area of the curve away 
from any control points adds a new 
control point to the curve at that point 
without changing the shape of the curve. 
Clicking away from the curve and control 
points deselects the control point that is 
currently selected.

– Part 2 is in the next issue (MXDJ 3-12)
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lthough earlier versions of 
ColdFusion supported Java 
objects and servlets to some 

degree, ColdFusion MX does so in a big 
way. This support opens up commercially 
available libraries to ColdFusion develop-
ers that were previously only available to 
J2EE shops. Moreover, you can now draw 
from an immense library of free code 
from within the Java open-source com-
munity. This availability greatly enhances 
the features of your own applications and 
speeds your ColdFusion-based solutions 
to market. Use these objects to provide 
back-end processing or user-interface 
functionality, or simplify coding CFM 
pages by supplementing ColdFusion 
functions and tags with Java TagLibraries.
	 Of particular note is how ColdFusion 
MX hosts and runs the Apache Jakarta 
Project’s Struts Action servlet. By imple-
menting Struts, ColdFusion MX offers a 
Model-2 Model-View-Controller (or MVC) 
environment for ColdFusion applications. 
This article is based on an implementa-
tion that uses ColdFusion MX Enterprise 
Edition on a Windows server. ColdFusion 
MX Enterprise Edition includes an embed-
ded J2EE server based on Macromedia 
JRun. In addition to hosting ColdFusion 
pages, Enterprise Edition can host JSPs 
and servlets. This article is also applicable 
to users running ColdFusion on third-
party application servers, although direc-
tory and filenames will vary somewhat.
	 First I give a brief description of my 
recent project, which shows how Struts 
and other Java objects provided a time-
saving solution to a ColdFusion project. 
Next I explain MVC architectures so that 
you can define the role that Struts plays 
in your application’s architecture. Then 
you learn how to transition your own 

development into a Struts framework. 
Finally I give you a sample application to 
help you get started using Struts in your 
own environment. (Code for this article 
can be downloaded from http://macro-
media.com/devnet/coldfusion/articles/
struts.html.)

Background: Saving Time 
with Struts
	 My Company: I work for a firm that 
creates websites and web applications for 
a wide range of businesses. We support 
many technologies, including Java and 
ColdFusion. On Java projects, we capital-
ize on open-source projects to speed 
solutions to market. Over the years, we 
have accumulated a large library of Java 
applications, objects, and services.
	 In the Java arena, we have adopted 
the Struts framework for our web ser-
vices. By using Struts to implement a 
true Model-2 MVC architecture, we can 
split work among our various groups. 
Our layout group is fluent in designing 
dazzling layouts using Macromedia Flash. 
Our business managers design concep-
tual business objects and workflow. Our 
developers use Struts to create in code 
the objects and flow described by the 
business managers. While the members 
of each group have great talents in their 
assigned areas, they require a cursory 
understanding of the others’ ingredients 
to a web-based application.
	 Our Client: One recent client was an 
internal ColdFusion development shop 
for a large association of plastic surgeons. 
Their task was to create web-based ser-
vices for their membership. The members 
use these services to promote their pri-
vate practices to the public. The success 
of these developers is measured by the 

number of referrals that are driven by the 
website to the doctors’ private practices. 
To do this, the association strives to be 
a clearinghouse from which potential 
patients can find the best doctor for their 
needs.
	 They run their website on Windows 
servers running ColdFusion MX 
Enterprise Edition. (They also happen to 
run CommonSpot, a content manage-
ment package from PaperThin. They 
often import ColdFusion pages into 
CommonSpot for consistency with the 
rest of the site. However, CommonSpot 
integration is beyond the scope of this 
article.)
	 The Project: We had to create private 
photo galleries that users could access 
from a doctor’s personal page. Doctors 
publish their most successful procedures 
using before-and-after photographs 
along with a description of the proce-
dure. The reason for this is so that the 
public will view these images and be 
encouraged to contact the doctor’s office 
for a consultation.
	 In addition, the association wanted 
to offer a general-purpose gallery to the 
public. By drawing customers to the site, 
the association would lead patients to a 
doctor’s private page and hopefully gen-
erate a referral. This general gallery would 
be a subset of the best examples found 
among the members’ private galleries.
	 This project offered us many challeng-
es. First of all, the images were categorized 
by procedure, each of which had a unique 
HTML form to describe the patient, treat-
ment, and results of the surgery. This form 
needed to be converted into a descriptive 
paragraph suitable for public viewing. 
Some form of template-technology would 
be required for that conversion.

Streamlining Application 
Development Using Struts in 
ColdFusion MX

Saving time with Struts
by steve belt

struts

a
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	 Second, the images submitted by the 
members were typically simple down-
loads from a digital camera. These images 
came in various dimensions and resolu-
tions and needed to be resized to stan-
dard dimensions before being stored on 
the servers. Additionally, photos needed 
to be watermarked with some sort of 
copyright text so discourage web surfers 
from appropriating them for their own 
uses.
	 Third, we needed to build in all the 
sorts of features you expect to find in a 
good online photo-gallery service: group-
ing, indexing, filtering, and so on.
	 The ColdFusion and Struts Solution: 
As with any business, competitive con-
cerns and published timelines required 
our client to roll out these new services 
quickly and reliably. The services also 
needed to match the look and feel of 
the rest of the website. In addition, the 
workflow was still being “worked out” as 
development began.
	 By using Struts, we enjoyed all the 
benefits of MVC architecture: Our layout 
team started designing the pages that 
reflected the look and feel of the exist-
ing ColdFusion MX site while our devel-
opers created the Beans that maintained 
the photo gallery pages. They also 
started building the generic structures 
for the procedure forms. We created 
and modified the process flow through 
simple modifications to the Struts con-
figuration file, and each team created 
independent timelines and contributed 
pieces to the project as they became 
available.
	 Java object support proved to be a 
great timesaver. In our private libraries, 
we already had a Java object that used 
the Graphics2D class to quickly complete 
the image-modification features. We 
implemented Apache Velocity (http://
jakarta.apache.org/velocity/)to create the 
paragraph templates in record time. From 
an earlier contract, we already had a skel-
eton Struts service for creating a website 

photo gallery. In all, ColdFusion’s support 
for Java and Struts allowed us to reuse 
code and work in parallel, effectively halv-
ing the time to complete the job.
	 (In all fairness, Macromedia tech-
nologies alone could have solved 
most of our requirements. ColdFusion 
pages, ColdFusion components, and 
Macromedia Flash components offer all 
the functionality we required. However, 
the ability to reuse open-source code, 
not to mention mine our private libraries, 
motivated many of our choices.)

Examining the Struts 
Framework’s Usefulness
	 To understand what Struts is, it helps 
first to review the terms defining the 
Model-View-Controller (MVC) approach 
to application development (see Figure 
1). When creating an application, the 
Model represents the information—the 
logic—that connects the information. 
To a Java developer, these roles are 
implemented by the storage media 
(such as database tables or data files) 
and the Beans that maintain them. To a 
ColdFusion developer, the model is sup-
ported by ColdFusion components and 
data sources.
	 The View is the interface used to pres-
ent the model to users, or obtain input to 
maintain that model. To a web developer, 
this View is passed between web brows-
ers and web servers as HTML pages and 
HTTP requests. Java developers create 
this interface using JavaServer Pages 
(JSPs), HTML, and JavaScript. ColdFusion 
shops use ColdFusion Pages (CFMs), 
HTML, and perhaps some JavaScript.
	 The Controller is responsible for 
directing traffic between and among 
the Model and View objects. As the 
View submits information, that informa-
tion is passed to the Controller, which 
implements the proper Model object for 
manipulating or storing the data. The 
Controller might invoke a new View to 
provide user feedback on the Model’s 

success or failure to process that informa-
tion. Likewise, when the View requests 
information, the request is submitted to 
the Controller. The Controller calls the 
necessary Model(s) to get the informa-
tion and then passes that information to 
an appropriate View object for display. 
How—or perhaps I should say where—
this Controller function is implemented is 
what differentiates Model-1 and Model-2 
implementations of the MVC design.
	 A full description of Model-1 and 
Model-2 MVC implementations can 
be found in Designing Enterprise 
Applications with the J2EE Platform, 
Second Edition by Inderjeet Singh, Beth 
Stearns, Mark Johnson, and the Sun 
Microsystems Enterprise Team. This book 
explains that in a Model-1 architecture, 
application flow is determined by the 
links embedded in the JSP or CFM pages; 
whereas in a Model-2 architecture, a serv-
let (Controller) is placed between the web 
pages (the View) and the business objects 
(the Model) to determine program flow.
	 So now with all that behind us, we 
can define Struts as follows: Struts is an 
implementation of the Controller func-
tionality in a Model-2 MVC architecture.
	 The next logical question to ask is 
how do you apply these various roles of 
MVC architecture to the ColdFusion MX 
environment? And which – if any – of 
these architectures is appropriate for your 
project?
	 Applications created using JSP or CFM 
pages have a tendency to embed some 
of the business logic within the current 
page. Although it’s possible to separate 
logic from Views, which are later com-
bined using includes, it’s not uncommon 
for developers—especially during the 
final hours of development—to embed 
small pieces of logic in the View layer. 
What’s more to the point is that the com-
mand richness of both JavaServer Pages 
and ColdFusion MX allows developers 
to break rules. Because these types of 
applications are considered non-MVC 

I work for a firm that creates websites and 
web applications for a wide range of 

businesses. We support many technologies, 
including Java and ColdFusion.
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conforming designs, they do not perform 
well over heavy loads. Non-MVC applica-
tions are perhaps most appropriate for 
prototypes and small-scale applications.
	 By using CFMs, which call the 
business logic defined in ColdFusion 
Components (CFCs), ColdFusion MX 
offers a Model-1 MVC architecture. This 
approach separates the business logic so 
that business objects can be reused by 
several areas of an application, or among 
different applications. Additionally, 
components can be spread among serv-
ers to distribute the processing burden 
among several CPUs. However, in a 
Model-1 architecture, application flow is 
still embedded in the CFM pages, which 
makes for difficult refactoring and logic 
reuse.
	 When you add Struts to a ColdFusion 
MX environment, you can say that 
ColdFusion MX supports the creation of 
a true Model-2 implementation of the 
MVC design pattern. We could create 
the Model-2 architecture by creating 
CFCs that serve the Controller func-
tion, but with Struts implementing the 
architecture is plugged-in rather than 
hard-coded. This means that business 
logic and the screens in front of them can 
be reused by different applications. This 
design also scales well to support heavy 
traffic, creates reusable components, and 
allows parallel tasks in projecting time-
lines.
	 From the programmer’s perspec-
tive, Struts is the traffic cop between 
and among Views (JSPs and CFMs) and 
Models (Beans and CFCs). It therefore 
provides methods for accepting data 
and passing it to Model objects. It also 

provides the Model object with destina-
tions to which control should be passed 
after processing. Each object uses values 
placed in the various scopes (request, ses-
sion, or application) to share information 
and results.
	 Perhaps if we follow a form submis-
sion through the processes you will bet-
ter understand what Struts does to the 
process by acting as the “Controller” of 
our Model-View-Controller architecture. 
You will see that this approach is quite 
different compared to other design archi-
tectures.
	 Start with a HTML form sitting in a 
user’s web browser. If we look at the page 
source, we see that the form’s action 
attribute is something similar to “action=/
do/processIt”. The user submits this form 
to the ColdFusion MX server.
	 The ColdFusion MX server has been 
set up so that all URLs of the form “/do/*” 
are redirected to Struts by the Struts 
Action servlet. This effectively passes the 
HTML form to Struts, which compares 
the remainder of the URL (the “/processIt” 
part) to its mapping definitions to select 
which Model will be passed the informa-
tion. To help things along, Struts first 
loads the form data into a Bean so that 
the Model can use simple getter and set-
ter methods to process the information.
	 When processing is complete (typi-
cally new information has been stored 
in the request or session scope), the 
model tells the Controller which of its 
possible forwards should be passed the 
request object (e.g., “I was successful, so 
forward to a success View” or “I failed, so 
forward to a please-try-again View”). The 
Controller then passes the session – with 

all its values placed in the request and 
session scopes – to the next Model for 
further processing, or the next View for 
presentation.
	 This map among Models and Views 
is stored in a configuration file (called 
struts-config.xml), which Struts reads 
when it’s initialized. Because this informa-
tion can be changed and reloaded, the 
application flow can be changed without 
having to rewrite Model or View com-
ponents. It is this aspect of Struts that 
allows developers, page designers, and 
business-process designers to work and 
update a project independently and in 
tandem.

Applying the Struts 
Framework to Your 
Application
	 Thanks to ColdFusion MX and Struts, 
you can plug in Java or ColdFusion 
technologies into either (or both) the 
Model or View layers of your MVC archi-
tecture. The Model can be provided by 
ColdFusion Components or JavaBeans 
and Java objects. The View can be pro-
vided by ColdFusion pages or JavaServer 
Pages. By allowing you to choose tech-
nologies, ColdFusion MX and Struts offer 
you a wide range of resources to assem-
ble an overall solution.
	 ColdFusion MX is happy to share 
its environment with Java servlets, and 
Struts is no exception. The Struts classes, 
along with its supporting libraries, can 
be placed in the server’s /lib folder, and 
mappings created using web.xml. You can 
then add classes and Struts-configuration 
files to the /lib folder for your specific 
application.
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	 Using <cfobject> tags you can access 
Java classes and Beans in ColdFusion 
pages and CFCs. GetContext() allows the 
CFM pages to pass information from and 
to servlets and JSPs. Terry Ford’s excellent 
article, “Using Java and J2EE Elements in 
ColdFusion MX Applications,” describes 
the interaction between Java objects and 
ColdFusion MX pages.
	 If you are already familiar with using 
Struts TagLibraries (a.k.a. “taglibs”) in 
JSPs, you will find that your CFMs can 
look just like your JSPs; the only appar-
ent difference lies in the import lines at 
the top of the page. Additionally, taglibs 
are compatible with CFMs. Struts taglibs 
offer a quick and easy way to embed 
Struts-maintained objects and values into 
your pages and forms. Check out the left 
navigational links on the Java Struts site 
to view the different taglibs documents 
for more information.
	 Struts includes one less-talked-about 
functionality called Tiles, which allows 
you to combine Struts views using a 
runtime configuration file (tiles-def.xml in 
the /WEB-INF folder). With Tiles you can 
reuse Views (CFMs or JSPs) among proj-
ects and customers, each with its own 
branding. Tiles also allows the developer 
of View objects to concentrate on the 
functionality of the View and not worry 
so much about visual customizations. 
Like the Views themselves, the templates 
employed by Struts Tiles can be CFM- or 
JSP-based.
	 An important conclusion that you 
(and the Java development company) 
should reach from all this is that by 
deploying a Struts application in a 
ColdFusion MX environment you make 
use of your most important asset: your 
existing development team. By remov-
ing the boundaries between Java and 
ColdFusion, ColdFusion MX has provided 
a rich set of functionality and an abbrevi-
ated development cycle.

Deploying the Sample 
Application
	 If you are like me, you learn more 
from working in code than from reading 
manuals. Let’s create a sample application 
using Struts on your ColdFusion MX serv-
er. This example is meant to demonstrate 
a Struts application in ColdFusion. It is 
not intended to demonstrate an example 
of a model Struts application. (Of course, 
it is not meant to be deployed in a pro-
duction environment either.)
	 I could have used Struts Tiles to lay 
out the screens – Tiles is truly worth 
getting to know – however, to keep this 
example as simple as possible, I have left 
Tiles out of the scenario.
	 You are welcome to follow along and 
cut and paste the code below to create, 
compile, and deploy this sample applica-
tion yourself. Otherwise, download the 
resource file cf_struts-files.jar (2 MB), 
which includes all the code and libraries 
you need to test the application on your 
own ColdFusion MX server.
	 Here is the scenario. We need to create 
a login framework for our website. The 
user opens the home page. While the user 
isn’t logged in, the left column displays a 
“please log in” form. Meanwhile, the main 
window shows a welcome-to-our-site-
please-log-in screen. Once the user logs 
in, the left column displays a menu and a 
logout link. At this time the main window 
displays the welcome screen.
	 As you transition from ColdFusion 
to Java, there are a few differences to 
be aware of. First, remember that Java 
is case-sensitive. Capitalization must 
be maintained among object names, 
configuration files, variable references, 
and even URLs. Also, when you are using 
the Struts taglib, it is useful to reference 
a local variable whose value was set 
using the GetContext() call. (You can see 
an example of this in view.cfm below.) 
Finally, get comfortable with the DevNet 

discussion groups – especially the “Using 
Java with ColdFusion” forum and archive, 
as it is very useful in solving issues.
	 When you debug your application, 
it is always useful to inspect the appli-
cation server logs in addition to the 
ColdFusion logs. In the case of ColdFusion 
MX Enterprise, these logs reside in 
[CfusionMX]/runtime/logs/. Often you 
will find complete stack traces for errors, 
which may appear as a single phrase in 
the application’s output.
	 Libraries: You will need to add the 
following JAR files in your [CfusionMX/
wwwroot]/WEB-INF/lib folder (if this 
folder does not already exist, then cre-
ate it): [Get this table from the follow-
ing URL, please: http://macromedia.
com/devnet/coldfusion/articles/struts05.
html#running]
	 Struts TagLibraries: TagLibrary 
Definitions (also called TLDs) are within 
the struts.jar that you added to the /lib 
folder. Extract the files with the .tld exten-
sion into the [CfusionMX-wwwroot]/WEB-
INF/lib folder. The specific filenames are 
struts-bean.tld, struts-html.tld, struts-
logic.tld, struts-nested.tld, struts-tem-
plate.tld, and struts-tile.tld.
	 Session Vars: In the ColdFusion MX 
configuration console, enable session 
variables using J2EE.
	 Web.xml Mapping: Struts is based 
on a servlet called Action that’s part of 
the struts.jar you added to the /lib folder 
above. The web.xml file (see Listing 1) 
tells ColdFusion MX about your servlet 
and how to process the URLs that call it.
	 Creating the Bean: A small Bean (see 
Listing 2) tracks the user’s full name, 
username, and password. In a real-world 
deployment, there would likely be many 
more attributes, as well as password 
encryption, but the goal here is to keep 
things simple.
	 Struts Action Form: The Action Form 
(see Listing 3) defines the data elements 

“ColdFusion MX is happy to 
share its environment with Java 

servlets, and Struts is no exception”
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being passed between the Action and the 
View. It is defined by extending the org.
apache.struts.action.ActionForm class.
	 Struts Action(s): The Struts Action 
implements or invokes the model busi-
ness logic. For this example, the logic 
has been coded directly into the Action; 
in a typical deployment, the business 
logic would be separated into separate 
business classes. This class is created 
by extending the org.apache.struts.
action.Action class. When Struts loads 
the Action, it looks for and runs the 
execute(...) method.
	 LoginUserAction (see Listing 4) 
checks the username and password. If 
they exist, the user’s full name is placed in 
the request scope. Based on the success 
of the username/password lookup, the 
Controller calls the next appropriate View. 
LogoutUserAction (see Listing 5) removes 
the full name from the request scope and 
tells the Controller to return to the next View.
	 The CFMs: These ColdFusion pages pro-
vide the displays and forms. As such, they 
play the role of the View in the Model-View-
Controller architecture. Note the uses of the 
Struts TagLibraries in the pages: Although 
you could have used straight ColdFusion 
tags, Struts taglibs will greatly simplify the 
next (and hopefully more complex) Struts 
application you build.
	 Login.cfm (see Listing 6) is the page 
users see when first coming to the site. In 
our example, it is only meant to indicate 
that they haven’t logged in yet. If users 
provide an invalid username/password 
combination, they will be returned to 
this page to try again. Welcome.cfm (see 
Listing 7) indicates that users have suc-
cessfully logged in.
	 Struts-config.xml: As it loads, the 
Struts servlet reads the struts-config.
xml file (see Listing 8) that determines 
which action should be called based on 
the HTTP-posts made to the Controller. 
Note how login.cfm creates a form where 
action=”loginUser”. Struts looks for the 
mapping named “/loginUser” to select 
an action (in this case, LoginUserAction). 
In turn, that action uses the defined for-

wards to select where control is passed 
for further processing or viewing.
	 Application Data File: The data file 
([CfusionMX/wwwroot]/WEB-INF/classes/
accounts.dat) comes in the .ini format. 
The attributes are valid user names and 
their values are the password and full 
name separated by a colon, as shown 
below. The application looks for this in 
the root of the class path (e.g., the /WEB-
INF/classes/ folder):

steveb = opensesame:Steve Belt

 joes = please:Joe Schmoe

Running the Sample 
Application
	 Once you have everything compiled 
and installed, you are ready to access 
the application. Using your web browser, 
reach your ColdFusion MX server using a 
URL similar to this:

http://localhost:8500/do/welcome

	 This should present you with the 
login.cfm page we just created. You may 
have noticed that we defined a default 
username and password when we created 
login.cfm. Certainly you would never do 
this in a real application but for this demo 
it makes testing and retesting the applica-
tion quicker. When you click the Submit 
button you should see the welcome.cfm 
page and when you click the Logout link 
you should return to login.cfm.
	 I hope this article gives you enough 
groundwork to begin using Struts in your 
own projects. From a business perspective, 
using Struts gives you an architecture that 
creates reusable products. Because Struts 
in ColdFusion MX is extremely similar to a 
pure-Java environment, you can use your 
existing teams to develop applications. 
And because of the separation of business, 
data, and layout disciplines, you can over-
lap project timelines to get your applica-
tion to market more quickly.
	 From a technical perspective, you 
should be ready to create your own appli-
cations. Whether you prefer CFMs or JSPs, 

you can bring your current skills to the 
task of creating a Struts-on-ColdFusion 
MX solution. While the demo application I 
described in this article is little more than 
a “Hello World” example, it should give 
you what you need to get started.
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Listing 1: The web.xml file ([CfusionMX/wwwroot]\WEB-INF\web.xml) tells 

ColdFusion MX about the servlet and how to process URLs that call it. 

... other <servlet></servlet> definitions ...

  <servlet>

    <servlet-name>action</servlet-name>

    <servlet-class>org.apache.struts.action.ActionServlet</servlet-

class>

    <init-param>

      <param-name>config</param-name>

      <param-value>/WEB-INF/struts-config.xml</param-value>

    </init-param>

    <init-param>

      <param-name>debug</param-name>

      <param-value>2</param-value>

    </init-param>

    <init-param>

      <param-name>detail</param-name>

      <param-value>2</param-value>

    </init-param>

    <init-param>

       <param-name>application</param-name>

       <param-value>ApplicationResources</param-value>

  </init-param>

    <load-on-startup>2</load-on-startup>

  </servlet>

  <!-- Standard Action Servlet Mapping -->

  <servlet-mapping>

    <servlet-name>action</servlet-name>

    <url-pattern>/do/*</url-pattern>

  </servlet-mapping>

  <!-- Struts Tag Library Descriptors -->

  <taglib>

    <taglib-uri>struts-bean</taglib-uri>

    <taglib-location>/WEB-INF/tlds/struts-bean.tld</taglib-location>

  </taglib>

  <taglib>

    <taglib-uri>struts-html</taglib-uri>

    <taglib-location>/WEB-INF/tlds/struts-html.tld</taglib-location>

  </taglib>

  <taglib>

    <taglib-uri>struts-logic</taglib-uri>

    <taglib-location>/WEB-INF/tlds/struts-logic.tld</taglib-location>

  </taglib>

  <taglib>

    <taglib-uri>struts-nested</taglib-uri>

    <taglib-location>/WEB-INF/tlds/struts-nested.tld</taglib-location>

  </taglib>

  <taglib>

    <taglib-uri>struts-tiles</taglib-uri>

    <taglib-location>/WEB-INF/tlds/struts-tiles.tld</taglib-location>

  </taglib>

<!-- End struts support -->

Listing 2: This Small Bean (com\macromedia\article\domainObjects\

UserBean) tracks the user’s full name, username, and password.

package com.macromedia.article.domainObjects;

public class UserBean

{

    public UserBean(){ } //Default Constructor

    // private attributes

    private String username;

    private String password;

    private String fullName;

    // Getter Methods

    public String getUsername(){ return username; }

    public String getPassword(){ return password; }

    public String getFullName(){ return fullName; }

    // Setter Methods

    public void setUsername(String username){ 

        this.username = username;

    }

    public void setPassword(String password){ 

        this.password = password; 

    }

    public void setFullName(String fullName){ 

        this.fullName = fullName; 

    }

}

Listing 3: The Action Form (com\macromedia\article\forms\UserActionForm) 

defines the data elements being passed between the Action and the View. 

package com.macromedia.article.forms;

import org.apache.struts.action.ActionForm;

import com.macromedia.article.domainObjects.UserBean;

public class UserActionForm extends ActionForm

{

    private UserBean userBean = new UserBean();

    public UserBean getUserBean(){ return userBean; }

    public void setUserBean(UserBean userBean){ this.userBean = user-

Bean; }

}

Listing 4: The Login User Action (com\macromedia\article\actions\

LoginUserAction) checks the username and password. If they are found, the 

user’s full name is placed in the request scope. Based on the success of the 

username/password lookup, the Controller calls the next appropriate View.

package com.macromedia.article.actions;

import java.io.IOException;

import java.io.InputStream;

import java.util.Properties;

import java.util.StringTokenizer;

import javax.servlet.ServletException;

import javax.servlet.http.HttpServletRequest;

import javax.servlet.http.HttpServletResponse;

import org.apache.struts.action.Action;

import org.apache.struts.action.ActionForm;

import org.apache.struts.action.ActionMapping;

import org.apache.struts.action.ActionForward;

import com.macromedia.article.forms.UserActionForm;

public class LoginUserAction extends Action

{

    /* the execute method is the automatically invoked by the Struts 

framework */

    public ActionForward execute(ActionMapping mapping,

                                 ActionForm form,

                                 HttpServletRequest request,

                                 HttpServletResponse response)

            throws IOException, ServletException

    {

        UserActionForm uaf = (UserActionForm) form;

        String fullName = getUser(uaf.getUserBean().getUsername(),

                                    uaf.getUserBean().getPassword() 

);

        if ( fullName == null || fullName.equals(“error”)){

            request.setAttribute(“fullName”, null);

            return mapping.findForward(“failure”);

        } else {

            request.setAttribute(“fullName”, fullName);

            return mapping.findForward(“success”);

        }

    }

    /* This method looks in the properties file for a list of users. 

If the user is found,

        it compares password values. If the username and password are 
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found, the fullname

        is returned; if there was an error loading the properties, 

“error” is returned;

        otherwise, null is returned */

    private static String getUser(String username, String password){

        InputStream propertiesStream = LoginUserAction.class.getRe-

sourceAsStream(“/accounts.dat”);

        if ( propertiesStream == null )

            return “error”;

        Properties props = new Properties();

        try {

            props.load(propertiesStream);

        } catch (IOException e) {

            System.out.println(“[PropertiesFile.getProperty()] ERROR: 

“);

            e.printStackTrace();

            return “error”;

        }

        String userRec = props.getProperty(username);

        if ( userRec == null || userRec == “” )

            return null;

        else {

            StringTokenizer st = new StringTokenizer(userRec);

            if ( password.equals( st.nextToken(“:”).trim() ) )

                return st.nextToken(“:”).trim();

            else

                return null;

        }

    }

}

Listing 5: The Logout user action (com\macromedia\article\actions\

LogoutUserAction) removes the full name from the request scope and tells the 

Controller to return to the next View. 

package com.macromedia.article.actions;

import java.io.IOException;

import javax.servlet.ServletException;

import javax.servlet.http.HttpServletRequest;

import javax.servlet.http.HttpServletResponse;

import org.apache.struts.action.Action;

import org.apache.struts.action.ActionForm;

import org.apache.struts.action.ActionMapping;

import org.apache.struts.action.ActionForward;

public class LogoutUserAction extends Action

{

    public ActionForward execute(ActionMapping mapping,

                                 ActionForm form,

                                 HttpServletRequest request,

                                 HttpServletResponse response)

            throws IOException, ServletException

    {

        request.setAttribute(“fullName”, null);

        return mapping.findForward(“success”);

    }

}

Listing 6: This is the page ([CfusionMX/wwwroot]/cfm/login.cfm) that users 

see when first coming to the site. It indicates that they have not yet logged in. 

If the username/password combination is invalid, users are returned to this 

page to try again.

<cfapplication name=”action” sessionmanagement=”yes”>

<cfimport taglib=”/WEB-INF/lib/struts-html.tld” prefix=”html”>

<cfset LoginForm= getPageContext().getRequest().getAttribute(“LoginFo

rm”)>

<html:html/>

<html:form action=”loginUser.do”>

	username: <html:text value=”steveb” name=”LoginForm” 

property=”userBean.username”/><br>

	password: <html:password value=”opensesame” name=”LoginForm” 

property=”userBean.password”/><br>

	<html:submit value=”submit”/>

</html:form>

Listing 7: This page ([CfusionMX/wwwroot]/cfm/welcome.cfm) indicates that 

the user has successfully logged in.

<cfapplication name=”action” sessionmanagement=”yes”>

<cfimport taglib=”/WEB-INF/lib/struts-html.tld” prefix=”html”>

<cfset fullName= getPageContext().getRequest().getAttribute(“fullName

”)>

<cfoutput>

<H1>Welcome #fullName#!</H1>

</cfoutput>

<br>

<br>

<html:link page=”/do/logoutUser”>logout</html:link><br>

Listing 8: The struts-config.xml file ([CfusionMX/wwwroot]/WEB-INF/struts-

config.xml) defines which action should be called based on the HTTP-posts 

made to the Controller.

<?xml version=”1.0” encoding=”ISO-8859-1” ?>

<!DOCTYPE struts-config PUBLIC

          “-//Apache Software Foundation//DTD Struts Configuration 

1.1//EN”

          “http://jakarta.apache.org/struts/dtds/struts-config_1_

1.dtd”>

<struts-config>

    <form-beans>

        <form-bean name=”loginForm” 

                type=”com.macromedia.article.forms.UserActionForm”/>

    </form-beans>

    <action-mappings>

        <action path=”/loginUser”

            type=”com.macromedia.article.actions.LoginUserAction”>

            <forward name=”success” path=”logged.in”/>

            <forward name=”failure” path=”loggoed.out”/>

        </action>

        <action path=”/logoutUser”

            type=”com.macromedia.article.actions.LogoutUserAction”>

            <forward name=”success” path=”logged.out”/>

        </action>

        <action path=”/welcome” type=”org.apache.struts.tiles.actions.

NoOpAction”>

            <forward name=”success” path=”logged.out”/>

        </action>

    </action-mappings>

    <!-- ====================================

              = Controller Configuration -->

    <controller

        processorClass=”org.apache.struts.tiles.

TilesRequestProcessor”/>

    <!-- ================================ Message Resources 

Definitions -->

    <message-resources parameter=”ApplicationResources” key=”org.

apache.struts.action.MESSAGE”/>

    <!-- ========== Tiles plugin ===================  -->

    <!-- comment following if struts1.0.x -->

    <plug-in className=”org.apache.struts.tiles.TilesPlugin”>

        <set-property property=”definitions-config”

            value=”/WEB-INF/tiles-defs.xml”/>

        <set-property property=”definitions-debug” value=”0”/>

        <set-property property=”definitions-parser-details” 

value=”0”/>

        <set-property property=”definitions-parser-validate” 

value=”true”/>

    </plug-in>

    <!-- end comment if struts1.0.x -->

    <plug-in className=”org.apache.struts.validator.ValidatorPlugIn”>

        <set-property

            property=”pathnames”

            value=”/WEB-INF/validator-rules.xml,/WEB-INF/validation.

xml”/>

    </plug-in>

</struts-config>
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